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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit Control+clic ou clic 
droit selon la configuration 
de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles et Formatage
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Qu’est-ce que Calc ?

Calc est le module tableur de LibreOffice. Vous pouvez saisir des données (ordinairement numé-
riques) dans un classeur puis les manipuler pour produire certains résultats.

Vous pouvez aussi saisir les données puis utiliser Calc dans un mode « Et si ? » en modifiant cer-
taines de ces données pour observer le résultat sans avoir à retaper la feuille ou le classeur en en-
tier.

Parmi les autres fonctionnalités de Calc, on trouve :

• des fonctions qui peuvent servir à créer des formules pour effectuer des calculs complexes 
sur les données ;

• des fonctions de base de données pour trier, stocker et filtrer les données ;

• des graphiques dynamiques : une large gamme de diagrammes en 2D et 3D ;

• des macros pour enregistrer et exécuter les tâches répétitives ; parmi les langages de script 
supportés, on trouve LibreOffice Basic, Python, BeanShell et JavaScript ;

• la capacité à ouvrir, modifier et enregistrer les classeurs de Microsoft Excel ;

• l’importation et l’exportation de classeurs dans de nombreux formats, parmi lesquels HTML, 
CSV, PDF et PostScript.

Compatibilité avec d’autres tableurs

Jokers

Les jokers simples, tels que l’astérisque (*), le point d’interrogation (?) et le tilde (~) provenant 
d’autres tableurs sont reconnus par LibreOffice. Les jokers sont courants dans d’autres tableurs et 
l’adoption d’une option semblable dans LibreOffice offre une meilleure compatibilité et un manie-
ment plus simple aux utilisateurs qui ne sont peut-être pas familiers de l’emploi des expressions 
régulières.

Syntaxe des formules

Par défaut, LibreOffice utilise une syntaxe propre pour les formules, dite syntaxe Calc A1, à la 
place de la syntaxe Excel A1 utilisée par Microsoft Excel. LibreOffice traduit de façon transparente 
l’une vers l’autre. Cependant, si vous avez vos habitudes avec Excel, vous désirerez peut-être 
changer la syntaxe par défaut utilisée dans Calc en sélectionnant Outils > Options… dans la 
barre de menu, puis en ouvrant la page LibreOffice Calc – Formule dans la boîte de dialogue Op-
tions pour choisir Excel A1 dans la liste déroulante Syntaxe de la formule.

Vous trouverez plus d’informations sur la syntaxe des formules dans le Guide Calc, au chapitre 7, 
Formules et fonctions.

Macros

Microsoft Office utilise un code écrit en Visual Basic for applications (VBA), tandis que LibreOffice 
utilise un code Basic basé sur son API (Application Programming Interface : Interface de Program-
mation de l’Application). Bien que ces deux langages de programmation soient les mêmes, les ob-
jets et les méthodes sont différents et ne sont donc pas totalement compatibles.
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LibreOffice peut cependant exécuter certains scripts en Visual Basic d’Excel si vous activez cette 
possibilité dans la page Chargement/enregistrement – Propriétés VBA de la boîte de dialogue Op-
tions (Outils > Options…).

Pour plus d’informations sur les macros, reportez-vous au Guide Calc, chapitre 12, Macros Calc.

Classeurs, feuilles de calcul et cellules

Calc travaille avec des éléments appelés classeurs. Un classeur est constitué de plusieurs feuilles 
de calcul individuelles, contenant chacune des cellules disposées en lignes et en colonnes. Une 
cellule donnée est identifiée par son numéro de ligne et la lettre de sa colonne.

Les cellules contiennent les éléments particuliers – textes, nombres, formules, etc. – qui consti-
tuent les données à afficher et à manipuler.

Chaque classeur peut posséder plusieurs feuilles de calcul et chaque feuille peut posséder plu-
sieurs cellules individuelles. Dans Calc, chaque feuille de calcul peut avoir au maximum 1 048 576 
lignes et 1 024 colonnes. LibreOffice Calc peut gérer jusqu’à 32 000 feuilles.

La fenêtre principale de Calc

Quand Calc démarre, la fenêtre principale s’ouvre (Figure 1). Les éléments de cette fenêtre sont 
décrits ci-dessous.

Barre de menu Barre d’outils standard Barre d’outils formatage

Volet latéral

Barre d’état

Cellule 
active

Zone de nom 
(référence de la cellule active)

Barre de 
formule

En-têtes de 
colonnes

Onglet de 
feuille de calcul

En-têtes de lignes

Barre de titre

Figure 1 : La fenêtre principale de Calc
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Remarque

Si une partie de la fenêtre de Calc (Figure 1) n’apparaît pas, vous pouvez l’afficher en utili-
sant le menu Affichage. Par exemple, Affichage > Barre d’état va basculer (afficher ou 
masquer) la barre d’état. Il n’est pas toujours nécessaire de tout afficher, comme sur la Fi-
gure 1; affichez ou masquez ce que vous voulez.

La barre de titre

La barre de titre, située tout en haut, affiche le nom du classeur ouvert. Quand celui-ci vient d’être 
créé, à partir d’un modèle ou d’un document vide, son nom est Sans nom X, où X est un nombre. 
Quand vous enregistrez le classeur pour la première fois, vous êtes invité à lui donner le nom de 
votre choix.

La barre de menu

La barre de menu est l’endroit où vous sélectionnez un des menus ; divers sous-menus peuvent 
apparaître pour vous donner plus de choix. Vous pouvez aussi personnaliser la barre de menu : 
voyez le Chapitre 14, Personnaliser LibreOffice pour plus d’informations.

• Le menu Fichier contient les commandes qui s’appliquent à la totalité du document ; par 
exemple, Ouvrir, Enregistrer, Assistants, Exporter au format PDF, Imprimer, Signatures nu-
mériques.

• Le menu Édition contient les commandes pour l’édition du document ; par exemple Annuler, 
Copier, Coller, Rechercher & remplacer, Suivi des modifications, Fusionner le document, etc.

• Le menu Affichage contient les commandes pour modifier l’apparence de l’interface utilisa-
teur de Calc ; par exemple Barres d’outils, En-tête de colonnes/lignes, Plein écran, Zoom, 
etc.

• Le menu Insertion contient les commandes pour insérer des éléments dans un classeur ; 
par exemple Image, Média, Objet, Contrôle de formulaire, Cadre flottant, Diagramme, Fonc-
tions, Caractères spéciaux, Forme, Table dynamique, Plage ou expression nommée, Com-
mentaire, Hyperlien, En-têtes et pieds de page, etc.

• Le menu Format contient les commandes pour modifier l’agencement d’un classeur ; par 
exemple Cellules, Page, Aligner, Fusionner les cellules, Zone d’impression, Formatage 
conditionnel, Thème pour le classeur, Image, Diagramme, Objet, etc.

Nouveau dans la version 6.0

Le menu dispose maintenant d’une entrée Styles.

• Le menu Styles contient les commandes pour appliquer les styles standard au contenu des 
cellules, groupes de cellules ou feuilles de calcul.

• Le menu Feuille contient les commandes les plus souvent utilisées pour gérer les feuilles ; 
par exemple Insérer et Supprimer des cellules, des colonnes, des lignes, des feuilles et des 
feuilles à partir d’un fichier, Basculer entre les types de référence, Lien vers des données ex-
ternes ainsi que Remplir les cellules, etc.

La fenêtre principale de Calc | 3



• Le menu Données contient les commandes pour manipuler les données dans votre clas-
seur ; par exemple Définir la plage, Trier, AutoFiltre, Statistiques, Table dynamique, Consoli-
der, etc.

• Le menu Outils contient diverses fonctions pour vous aider à vérifier et à personnaliser votre
classeur, par exemple Orthographe, Partager le classeur, Protéger la feuille, Macros, Re-
cherche de valeur cible, Solveur, Paramétrage des filtres XML, Gestionnaire des extensions, 
etc.

• Le menu Fenêtre contient les commandes pour l’affichage de la fenêtre ; par exemple Nou-
velle fenêtre, Fermer la fenêtre.

• Le menu Aide contient des liens vers le système d’aide qui accompagne le logiciel et 
d’autres fonctions diverses ; par exemple Aide de LibreOffice, Information de licence, Guides
de l’utilisateur, Vérifier les mises à jour, Envoyer un retour ou Faire un don à LibreOffice.

Barres d’outils

Dans la disposition par défaut, à l’ouverture de Calc, les barres d’outils Standard et Formatage 
sont ancrées en haut de l’espace de travail (Figure 1).

Les barres d’outils de Calc peuvent être soit ancrées à une position fixe, soit flottantes, ce qui vous
permet de les déplacer à une position plus pratique sur votre espace de travail. Les barres d’outils 
ancrées peuvent être libérées et soit déplacées à une position d’ancrage différente sur l’espace de
travail, soit laissées flottantes. Les barres d’outils qui sont flottantes quand on les ouvre peuvent 
être ancrées à une position fixe sur votre espace de travail.

Vous pouvez choisir une barre d’outils unique à la place des deux barres de la configuration par 
défaut. Elle propose les commandes les plus utilisées. Pour l’activer, dans le menu Affichage > 
Barre d’outils, sélectionnez Standard (mode compact) et décochez Standard et Formatage.

L’ensemble par défaut des icônes (parfois appelées boutons) des barres d’outils offre une grande 
variété de commandes et de fonctions courantes. Vous pouvez aussi ajouter ou supprimer des 
icônes des barres d’outils, voyez pour cela le Chapitre 14, Personnaliser LibreOffice pour plus d’in-
formations.

Si vous placez le pointeur de la souris au-dessus d’une des icônes, une petite boîte, appelée info-
bulle, apparaît. Elle donne une brève explication de la fonction de l’icône. Pour une explication plus
détaillée, choisissez Aide > Qu’est-ce que c’est ? et placez le pointeur de la souris sur l’icône. 
Pour désactiver cette fonction, cliquez dessus ou appuyez sur la touche Échap. Les astuces dé-
taillées (info-ballons) peuvent être activées ou désactivées depuis la page LibreOffice > Général 
de la boîte de dialogue Options (Outils > Options).

La barre de formule

La barre de formule est située au-dessus de la feuille de calcul dans l’espace de travail de Calc. 
Elle est ancrée de façon permanente à cette position et elle ne peut pas être rendue flottante. Si 
elle n’est pas visible, sélectionnez Affichage dans la barre de menu et choisissez Barre de for-
mule.

Figure 2 : La barre de formule

De gauche à droite sur la Figure 2, la barre de formule est constituée des éléments suivants :

4 | Débuter avec Calc



• la Zone de nom indique la référence de la cellule actuellement active par une combinaison 
d’une lettre et d’un nombre, par exemple A1. La lettre indique la colonne et le nombre la ligne
de la cellule sélectionnée. Si vous avez sélectionné une plage de cellules qui a reçu un nom, 
celui-ci est affiché dans cette boîte. Vous pouvez aussi taper une référence de cellule dans la
zone de nom pour sauter à la cellule référencée. Si vous tapez le nom d’une plage nommée 
et que vous appuyez sur la touche Entrée, la plage nommée est sélectionnée et affichée ;

• l’Assistant Fonctions  ouvre une boîte de dialogue où vous pouvez parcourir une liste 
des fonctions disponibles. Cette boîte peut être très utile, car elle indique aussi les para-
mètres de ces fonctions ;

• l’icône Somme  : quand on clique sur celle-ci, Calc calcule le total des nombres dans les 
cellules au-dessus de la cellule active et place le résultat dans celle-ci. S’il n’y a pas de 
nombres au-dessus de la cellule active, la somme est effectuée sur celles de gauche. Quand
cette icône est utilisée, Calc suggère l’étendue de la somme par un cadre coloré, mais il ne 
valide pas la formule. Vous devez confirmer la zone proposée en appuyant sur Entrée ou la
rejeter en appuyant sur Échap. Vous pouvez aussi la modifier en tirant le cadre ou ses bords
avec la souris. Les icônes  et  de la barre de formule jouent les mêmes rôles que les 
touches Échap et Entrée ;

• l’icône Fonction  : quand on clique sur celle-ci, Calc insère un signe égal (=) dans la cel-
lule active et dans la ligne de saisie, ce qui permet de saisir la formule. La zone de nom pro-
pose alors les fonctions les plus courantes pour vous offrir un accès rapide à leurs noms et à
leurs syntaxes ;

• la ligne de saisie affiche le contenu de la cellule active (donnée, formule ou fonction) et 
vous permet de modifier celui-ci. Pour transformer la ligne de saisie en une zone de saisie 
multi-ligne pour les très longues formules, cliquez sur le bouton de droite.

Vous pouvez aussi éditer le contenu d’une cellule directement dans celle-ci en faisant un double 
clic sur la cellule elle-même ou en appuyant sur la touche F2. Quand vous saisissez une nouvelle 

donnée, les icônes Somme et Fonction sont remplacées par les icônes Annuler  et Accepter
.

Le contenu de la cellule courante (donnée, formule ou fonction) est affiché dans la Ligne de sai-
sie, qui est le reste de la barre de formule. Vous pouvez modifier le contenu de la cellule courante 
soit ici, soit dans la cellule courante. Pour modifier dans la zone Ligne de saisie, cliquez dans la 
zone, puis tapez vos modifications. Pour modifier dans la cellule courante, double-cliquez simple-
ment dans la cellule.

Remarque

Dans un classeur, le terme « fonction » va bien au-delà des simples fonctions mathéma-
tiques. Voyez le Guide Calc, Chapitre 7, Utiliser les formules et les fonctions pour plus d’in-
formations.

La barre d’état

La barre d’état de Calc (Figure 3) offre des informations sur le classeur ainsi que des moyens ra-
pides et pratiques pour modifier certaines de ses propriétés. La plupart des champs sont sem-
blables à ceux des autres éléments de LibreOffice : voyez le Chapitre 1, Introduction à LibreOffice 
de ce guide et le Guide Calc, Chapitre 1, Introduction à Calc pour plus d’informations.
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Nombre et 
numéro de page

Informations sur 
la sélection

LangueStyle de 
page

Mode de 
sélection

Signature 
électronique

Information sur 
l’objet ou la cellule

Réglage 
du zoom

Pourcentage 
de zoom

Mode d’insertion Document modifié

Figure 3 : La barre d’état de Calc

La barre d’état offre un moyen rapide pour effectuer quelques opérations mathématiques sur les 
cellules sélectionnées dans la feuille de calcul. Vous pouvez calculer la moyenne et la somme, 
compter les éléments de la sélection et plus encore en faisant un clic droit sur la zone d’informa-
tions sur la cellule dans la barre d’état puis en choisissant les opérations que vous désirez y voir 
affichées.

Le volet latéral

Le volet latéral de Calc (Affichage > Volet latéral) (Figure 4) est situé à droite de la fenêtre. C’est 
un mélange de barre d’outils et de boîte de dialogue qui est constitué de cinq onglets : Propriétés,
Styles et formatage, Galerie, Navigateur et Fonctions. Chacun correspond, dans la barre d’on-
glets à droite du volet latéral, à une icône qui vous permet de passer de l’un à l’autre. Il est sem-
blable au volet latéral de Writer (présenté aux chapitres 1 et 4 de ce livre).

Les onglets sont décrits ci-dessous.

• L’onglet Propriétés contient cinq panneaux.

─ Le panneau Styles permet de choisir le style de la cellule, de l’actualiser et d’en créer de 
nouveaux.

─ Le panneau Caractères fournit les contrôles nécessaires pour formater le texte, par 
exemple la police, sa taille et sa couleur. Certains contrôles, comme Exposant ( ), ne 
sont actifs que si le curseur de texte est situé dans la ligne de saisie de la barre de for-
mule ou dans la cellule.

─ Le panneau Format numérique permet de modifier rapidement le format des nombres 
(nombre de décimales, monnaie, dates ou texte numérique). Des contrôles pour des 
champs numériques et étiquettes pour les formulaires sont aussi disponibles.

─ Le panneau Alignement contrôle l’alignement du texte de diverses façons, y compris ho-
rizontalement et verticalement, ainsi que le retour à la ligne, le retrait, la fusion de cellules,
l’orientation du texte et l’empilement vertical.

─ Le panneau Apparence de cellule offre des options pour définir la couleur d’arrière-plan 
et le format des bordures (couleur et style de lignes, grille) de la cellule.

Chaque panneau possède un bouton Plus d’options qui ouvre une boîte de dialogue offrant
un plus grand nombre de choix. Pendant qu’une de ces boîtes de dialogue est ouverte, l’édi-
tion du document est impossible.
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Configuration du 
volet latéral

Barre de titre

Bouton plus d’options

Onglets

Contenu de l’onglet

Titre de panneau

Contenu du panneau

Bouton 
Afficher/
Masquer

Figure 4 : Volet latéral de Calc avec la page Propriétés ouverte.

• L’onglet Styles et formatage, qui s’ouvre aussi en sélectionnant Affichage > Gérer les 
styles (raccourci clavier F11) dans la barre de menu, permet d’appliquer des styles aux cel-
lules ou aux pages, de les mettre à jour ou d’en créer de nouveaux.

• L’onglet Galerie, qui s’ouvre aussi en sélectionnant Affichage > Galerie dans la barre de 
menu, offre un choix d’image et de sons que vous pouvez incorporer à votre classeur.

• L’onglet Navigateur ne contient qu’un panneau qui est pratiquement le même que la fenêtre 
Navigateur qui s’ouvre en sélectionnant Affichage > Navigateur (raccourci clavier F5) dans
la barre de menu. La seule différence est que le bouton Contenu est absent du panneau du 
volet latéral.

• L’onglet Fonctions ne contient qu’un panneau qui offre les mêmes possibilités que la fenêtre
qui s’ouvre en sélectionnant Insertion > Fonction… dans la barre de menu.

À droite de la barre de titre de chaque plateau ouvert un bouton Fermer le volet latéral (X) permet
de fermer l’onglet en ne laissant que la barre d’icônes ouverte. Cliquer sur l’icône de n’importe quel
onglet ouvre de nouveau celui-ci.

Le Volet latéral peut être masqué ou affiché, s’il est déjà masqué, en cliquant sur le bouton Affi-
cher/Masquer de la bordure. Vous pouvez ajuster la largeur du plateau en tirant avec la souris sur
la bordure gauche du volet latéral.
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Agencement du classeur

Cellules individuelles

La partie principale de l’espace de travail de Calc affiche des cellules disposées en grille. Chacune
est placée à l’intersection d’une colonne et d’une ligne.

Au sommet des colonnes et à gauche des lignes, on trouve une série d’en-têtes qui contiennent 
des lettres ou des nombres. Les en-têtes de colonnes utilisent des caractères alphabétiques qui 
commencent à A et continuent vers la droite. Les en-têtes de lignes utilisent des caractères numé-
riques qui débutent à 1 et augmentent vers le bas.

Ces en-têtes de colonnes et de lignes forment les références des cellules qui apparaissent dans la
zone de nom de la barre de formule (Figure 2). Si les en-têtes ne sont pas visibles dans votre clas-
seur, sélectionnez Affichage dans la barre de menu et cliquez sur En-têtes de colonnes/lignes.

Onglets de feuille de calcul

Dans Calc, vous pouvez avoir plusieurs feuilles de calcul dans un classeur. En bas de la grille de 
cellule, se trouvent des onglets qui représentent les feuilles que votre classeur contient. Cliquer sur
un onglet donne accès à une feuille particulière et l’affiche. Une feuille active est indiquée par un 
onglet blanc (dans la disposition par défaut de Calc). Vous pouvez aussi sélectionner plusieurs 
feuilles en appuyant sur la touche Ctrl pendant que vous cliquez sur les onglets (Voir « Sélec-
tionner des feuilles », page 20).

Pour modifier le nom par défaut d’une feuille (Feuille1, Feuille2, etc.), faites un clic droit sur l’onglet
de la feuille et sélectionnez Renommer la feuille dans le menu contextuel, ou faites un double clic
sur l’onglet. Une boîte de dialogue s’ouvre où vous pouvez saisir un nouveau nom pour la feuille. 
Cliquez sur OK quand vous avez fini pour refermer la boîte de dialogue.

Pour modifier la couleur de l’onglet, faites un clic droit sur celui-ci et sélectionnez Couleur d’on-
glet dans le menu contextuel pour ouvrir la boîte de dialogue Couleur d’onglet (Figure 5). Choisis-
sez votre couleur et cliquez sur OK quand vous avez fini pour refermer la boîte de dialogue. Pour 
ajouter de nouvelles couleurs à la palette, voyez le Chapitre 14, Personnaliser LibreOffice pour 
plus d’informations.

Figure 5 : La boîte de dialogue Couleur d’onglet
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Ouvrir des fichiers CSV

Les fichiers à Valeurs Séparées par des Virgules (Comma-Separated-Values : CSV) sont des fi-
chiers texte qui peuvent être lus, affichés et modifiés dans une seule feuille de calcul. Chaque 
ligne d’un fichier CSV représente une ligne d’une feuille de calcul. Les virgules, les points-virgules 
ou d’autres caractères sont utilisés pour séparer les cellules. Le texte peut être saisi entre des 
guillemets ; les nombres sont saisis sans guillemets.

Remarque

La plupart des fichiers CSV proviennent de tables, requêtes et rapports de bases de don-
nées où des calculs et diagrammes supplémentaires sont nécessaires. Sous Microsoft Win-
dows, les fichiers CSV ont souvent l’extension .xls pour ressembler à des fichiers Excel mais
leur structure interne reste celle des fichiers CSV.

Pour ouvrir un fichier CSV dans Calc :

 1) Choisissez Fichier > Ouvrir dans la barre de menu et recherchez le fichier CSV que vous 
voulez ouvrir.

 2) Sélectionnez le fichier et cliquez sur Ouvrir. Par défaut un fichier CSV a l’extension .csv 
mais certains ont pour extension .txt.

 3) Dans la boîte de dialogue Import de texte (Figure 6), sélectionnez les diverses options dispo-
nibles pour importer un fichier CSV dans un classeur de Calc.

 4) Cliquez sur OK pour ouvrir le fichier.

Voici les diverses options pour l’importation des fichiers CSV dans une feuille de calcul de Calc.

• Dans la section Importer,

─ l’option Jeu de caractères définit le jeu de caractères à utiliser pour importer le fichier,

─ l’option Langue détermine comment les chaînes de nombres sont importées.

Si la langue est définie comme Par Défaut pour l’importation CVS, Calc utilisera la langue 
définie globalement. Si elle est définie comme langue spécifique, celle-ci sera utilisée pour
importer les nombres,

─ l’option À partir de la ligne précise la ligne où vous désirez commencer l’importation. Les 
lignes sont visibles dans la fenêtre d’aperçu au bas de la boîte de dialogue.

• La section Options de séparateur précise si vos données occupent une largeur fixe ou 
quels sont les séparateurs utilisés comme délimiteurs.

─ Si l’option Largeur fixe est cochée, les données sont réparties en colonnes de largeur 
fixée (nombre égal de caractères). Cliquez sur la règle dans la fenêtre d’aperçu pour défi-
nir la largeur.

─ Si l’option Séparé par est cochée, choisissez le séparateur utilisé dans vos données pour 
les délimiter. Si vous choisissez Autre, vous pouvez préciser le caractère utilisé pour sé-
parer vos données en colonnes. Le séparateur personnalisé doit aussi être contenu dans 
vos données.

─ L’option Fusionner les séparateurs permet de combiner des délimiteurs consécutifs et de 
supprimer les champs de données vides.
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─ L’option Séparateur de texte permet de sélectionner un caractère qui délimite les données
textuelles.

Figure 6 : Boîte de dialogue Import de texte, avec la virgule, le point-virgule et la tabulation comme
séparateurs de colonnes et le guillemet comme séparateur de texte

• Autres options

─ Si l’option Champ entre guillemets comme texte est cochée, les champs et cellules dont 
les valeurs sont entièrement entre guillemets (le premier et le dernier caractères de la va-
leur sont égaux au délimiteur de texte) sont importés comme texte.

─ Si l’option Détecter les nombres spéciaux est cochée, Calc va automatiquement détecter 
tous les formats de nombres, y compris les formats spéciaux tels que les dates, les 
heures et la notation scientifique. La langue sélectionnée influence aussi la manière dont 
ces nombres spéciaux sont reconnus puisque des langues et des régions différentes 
peuvent avoir des conventions différentes pour de tels nombres.

Si cette option n’est pas cochée, Calc ne va détecter et convertir que les nombres déci-
maux. Les autres, y compris les nombres formatés en notation scientifique, seront impor-
tés sous forme de texte. Une chaîne représentant un nombre décimal peut posséder des 
chiffres de 0 à 9, des séparateurs de milliers et un séparateur décimal. Les séparateurs 
des milliers et décimal peuvent changer selon la langue et la région sélectionnées.
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• La section Champs montre l’aspect de vos données séparées en colonnes.

─  Sélectionnez une colonne dans la fenêtre d’aperçu et le type de données à appliquer aux 
données importées dans la liste déroulante Type de colonne. Les choix proposés sont les 
suivants.

Standard  : Calc détermine le type de données.

Texte : les données importées sont traitées comme du texte.

Date(JMA)/Date(MJA)/Date(AMJ) : les données importées sont traitées comme des dates 
avec le format indiqué.

Anglais US : les nombres formatés en anglais US sont recherchés et inclus indépendam-
ment de la langue du système. Aucun format de nombre n’est appliqué. S’il n’y a pas d’en-
trées en anglais US, le format Standard est appliqué.

Masquer : les données de la colonne ne sont pas importées.

La méthode ci-dessus fonctionne également avec les fichiers TXT.

! Attention

La méthode d’ouverture des fichiers CSV est propre au module Calc. Si vous ouvrez un fi-
chier *.csv ou *.txt avec un autre module de LibreOffice (Writer par exemple), le comporte-
ment sera différent.

Enregistrer les classeurs

Pour enregistrer un classeur, voyez le Chapitre 1, Introduction à LibreOffice pour plus de détails 
sur la façon d’enregistrer manuellement ou automatiquement des fichiers. Calc permet aussi d’en-
registrer les classeurs dans toute une gamme de formats et aussi de les exporter dans les formats 
de fichiers PDF, HTML et XHTML, ainsi que sous forme d’images JPEG et PNG ; voyez le Guide 
Calc, Chapitre 6, Imprimer, exporter et envoyer par courrier électronique pour plus d’informations.

Les classeurs peuvent être enregistrés de trois manières :

• Appuyez sur les touches Ctrl+S.

• Sélectionnez Fichier > Enregistrer (ou Tout enregistrer ou Enregistrer sous) dans la 
barre de menu.

• Cliquez sur le bouton Enregistrer ( ) de la barre d’outils Standard.

Si le classeur n’a pas encore été sauvegardé précédemment, chacune de ces actions ouvrira la 
boîte de dialogue Enregistrer sous. Vous pourrez alors spécifier le nom du classeur et l’emplace-
ment du stockage.

Remarque

Si le classeur a été enregistré précédemment, utiliser la commande Enregistrer (ou Tout 
enregistrer) va écraser la version existante. Toutefois, vous pouvez enregistrer le classeur 
à un emplacement différent ou avec un nom différent en sélectionnant Fichier > Enregistrer
sous ou Fichier > Enregistrer une copie…
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Enregistrer dans d’autres formats de classeurs

Si vous devez échanger des fichiers avec des utilisateurs qui ne peuvent pas les recevoir dans le 
Format Open Document (ODF) (*.ods), que Calc utilise par défaut, vous pouvez enregistrer un 
classeur dans un autre format.

 1) Important – Enregistrez tout d’abord votre classeur dans le format de fichier ODF utilisé par 
LibreOffice, *.ods. Si vous ne le faites pas, toutes les modifications que vous aurez pu effec-
tuer depuis le moment de votre dernier enregistrement apparaîtront uniquement dans la nou-
velle version du document.

 2) Sélectionnez Fichier > Enregistrer sous dans la barre de menu pour ouvrir la boîte de dia-
logue Enregistrer sous (Figure 7)

 3) Dans la zone de saisie Nom de Fichier, vous pouvez saisir un nouveau nom pour votre clas-
seur.

 4) Dans la liste déroulante Type de fichier, sélectionnez le type de format que vous désirez utili-
ser.

 5) Si l’option Extension automatique du nom de fichier est cochée, l’extension correcte pour le 
format que vous avez sélectionné sera ajoutée au nom du fichier.

 6) Cliquez sur Enregistrer.

Figure 7 : Enregistrer un classeur au format Microsoft Excel

 7) Chaque fois que vous cliquez sur Enregistrer, la boîte de dialogue Confirmer le format de fi-
chier (Figure 8) s’ouvre. Cliquez sur Utiliser le format XXX … pour terminer l’enregistrement
dans le format que vous avez choisi ou cliquez sur Utiliser le format ODF pour enregistrer 
le classeur dans le format .ods de Calc.
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Figure 8 : Message de confirmation lors de l’enregistrement dans un format autre qu’ODF

 8) Si vous choisissez le format Texte CSV (*.csv) pour votre classeur, la boîte de dialogue Ex-
port de fichiers texte (Figure 9) s’ouvre. Vous pouvez y choisir le jeu de caractères, le sépa-
rateur de champ, le séparateur de texte, etc. à utiliser pour le fichier CSV.

Figure 9 : Choix des options lors de l’export en Texte CSV

! Attention

À partir de ce moment, toutes les modifications que vous apporterez au classeur au-
ront lieu uniquement dans le document au nouveau format. Vous avez changé le nom 
et le type de fichier de votre document. Si vous voulez revenir en arrière pour travailler avec 
la version *.ods de votre classeur, vous devez l’ouvrir à nouveau.

Une autre solution consiste à utiliser la commande Enregistre une copie, plutôt que Enre-
gistrer sous : dans ce cas, les nouvelles modifications sont toujours faites dans le fichier au
format original.

Conseil

Pour que Calc enregistre par défaut les documents dans un format autre que ODF, sélec-
tionnez Outils > Options dans la barre de menu ; dans la boîte de dialogue Options, ouvrez
la page Chargement/Enregistrement – Général. Dans la section Format de fichier par dé-
faut et paramétrage ODF, sélectionnez Classeur dans la liste déroulante Type de docu-
ment et votre format favori dans la liste déroulante Enregistrer systématiquement sous.
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Exporter le contenu sous forme d’image

Si vous désirez envoyer une partie de votre classeur à un collègue ou la publier sur Internet, Calc 
peut exporter une sélection de cellules ou un groupe de formes sélectionnées (figures) au format 
d’image JPG ou PNG.

 1) Sélectionnez les cellules ou le groupe de figures dans votre classeur.

 2) Choisissez Fichier > Exporter… dans la barre de menu pour ouvrir la boîte de dialogue 
d’exportation.

 3) Saisissez un nom pour votre image dans le champ Nom de fichier.

 4) Sélectionnez le format de fichier dans la liste déroulante Type.

 5) Cochez la case Sélection puis cliquez sur le bouton Exporter.

Naviguer dans les classeurs

Calc propose de nombreuses façons de naviguer à l’intérieur d’un classeur, de cellule à cellule et 
de feuille à feuille. Vous pouvez en général utiliser la méthode que vous préférez.

Déplacement d’une cellule à l’autre

Quand une cellule est sélectionnée ou activée, ses bordures sont plus épaisses. Quand un groupe
de cellule est sélectionné, l’espace des cellules est coloré. La couleur de la bordure de la cellule 
activée et celle du groupe sélectionné dépendent du système d’exploitation utilisé et de la façon 
dont vous avez configuré LibreOffice.

• Utiliser la souris : Placez le pointeur de la souris sur la cellule et cliquez avec le bouton 
gauche de la souris. Pour activer une autre cellule avec la souris, déplacez simplement le 
pointeur de la souris sur la cellule que vous voulez activer et faites un clic avec le bouton 
gauche.

• Utiliser une référence de cellule : Sélectionnez ou effacez la référence de cellule qui se 
trouve dans la zone de nom de la barre de formule (Figure 1, page 2). Tapez la référence de 
la cellule où vous voulez aller et appuyez sur Entrée. Les références de cellules peuvent 
être saisies en majuscules ou en minuscules : a3 ou A3, par exemple, sont identiques.

• Utiliser le Navigateur : Cliquez sur le bouton Navigateur  de la barre d’outils Standard 
(ou appuyez sur F5) pour afficher le Navigateur, ou cliquez sur l’onglet du Navigateur dans 
le volet latéral. Tapez la référence de cellule dans les deux champs du haut, intitulés Colonne
et Ligne, et appuyez sur Entrée. Dans la Figure 10, le Navigateur sélectionnera la cellule 
H21.

Pour plus d’informations sur l’utilisation du Navigateur, le chapitre 1, Introduction à Calc, du 
Guide Calc.
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Figure 10 : Le Navigateur de Calc

• Utiliser les touches Tab et Entrée

─ Appuyer sur Entrée ou Maj+Entrée active respectivement par défaut la cellule au-des-
sous et au-dessus de la cellule actuellement active dans la même colonne.

─ Appuyer sur Tab ou Maj+Tab active respectivement la cellule à droite et à gauche de la 
cellule actuellement active sur la même ligne.

• Utiliser les touches flèches : Appuyer sur les touches flèches du clavier déplace le focus 
dans la direction des flèches.

• Utiliser Début, Fin, Page précédente et Page suivante

─ Début active la première cellule d’une ligne.

─ Fin active la cellule la plus à droite de la ligne et qui contient une donnée.

─ Page suivante (PgSuiv) active la cellule écran complet en dessous en faisant défiler
l’affichage.

─ Page précédente (PgPrec) active la cellule écran complet au-dessus en faisant défi-
ler l’affichage.

Déplacement d’une feuille à l’autre

Chaque feuille d’un classeur est indépendante des autres, bien qu’elles puissent être liées par des 
références de l’une à l’autre. Il y a trois façons de naviguer entre les différentes feuilles d’un clas-
seur.

• Avec le navigateur – Dans le navigateur (Figure 10, page 15), cliquez sur le symbole + à 
côté de Feuilles pour voir la liste des feuilles du classeur. Faites un double clic sur la feuille 
que vous voulez atteindre.

• Avec le clavier – Appuyez sur Ctrl+Page suivante pour vous déplacer d’une feuille vers
la droite et appuyez sur Ctrl+Page précédente pour vous déplacer d’une feuille vers la 
gauche.
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• Avec la souris – Cliquer sur un des onglets en bas du classeur permet de sélectionner la 
feuille correspondante.

Si votre classeur contient beaucoup de feuilles, certains des onglets peuvent alors être cachés 
derrière la barre de défilement horizontal en bas de l’écran. Si c’est le cas :

• Les quatre boutons à la gauche des onglets peuvent alors faire apparaître les onglets ca-
chés. La Figure 11 montre comment le faire.

Figure 11 : Flèches d’onglet des feuilles

• Un clic droit sur un des boutons ouvre un menu contextuel où vous pouvez sélectionner une 
feuille (voir Figure 12).

Figure 12 : Un clic droit sur un des cinq boutons

• Si les noms des onglets dépassent la largeur de l’écran, il est possible d’afficher les noms 
des onglets cachés en faisant tourner la molette de la souris lorsque le curseur est au-des-
sus d’un onglet.

Remarques

Notez que les feuilles ne sont pas forcément numérotées dans l’ordre. La numérotation des 
feuilles est arbitraire. La liste de la Figure 12 indique que Feuille6 est en quatrième position 
parmi les dix feuilles du classeur. Il est recommandé de renommer les feuilles pour les re-
connaître plus facilement.

16 | Débuter avec Calc

Onglets des feuillesInsérer une nouvelle feuille à la fin

Aller à la dernière feuille

Aller à la feuille suivante

Aller à la feuille précédente

Aller à la première feuille



Navigation avec le clavier

Vous pouvez parcourir un classeur avec le clavier, en appuyant sur une touche ou une combinai-
son de touches. Dans ce cas, appuyez sur plusieurs touches à la fois. Le Tableau 1 donne la liste 
des touches et combinaisons de touches que vous pouvez utiliser pour parcourir un classeur dans 
Calc.

Tableau 1 : Se déplacer de cellule à cellule en utilisant le clavier

Combinaison 
de touches

Mouvement par rapport à la cellule active

→ Active la cellule sur la droite

← Active la cellule sur la gauche

↑ Active la cellule au-dessus

↓ Active la cellule en dessous

Ctrl+→ Si la cellule active est vide, active la première cellule à droite sur la même ligne 
qui contient une donnée.
Si la cellule active contient des données, active la dernière cellule à droite dans
la même plage de cellules remplies sur la même ligne.
S’il n’y a plus de cellule à droite contenant des données, active la dernière cel-
lule à droite sur la même ligne.

Ctrl+← Si la cellule active est vide, active la dernière cellule à gauche sur la même 
ligne qui contient une donnée.
Si la cellule active contient des données, active la première cellule à gauche 
dans la même plage de cellules remplies sur la même ligne.
S’il n’y a plus de cellule à gauche contenant des données, active la première 
cellule à gauche sur la même ligne.

Ctrl+↑ Si la cellule active est vide, active la première cellule au-dessus qui contient 
des données dans la même colonne.
Si la cellule active contient des données, active la première cellule dans la 
même plage de cellules remplies dans la même colonne.
S’il n’y a plus de cellule au-dessus contenant des données, active la première 
cellule de la colonne.

Ctrl+↓ Si la cellule active est vide, active la première cellule en dessous qui contient 
des données dans la même colonne.
Si la cellule active contient des données, active la dernière cellule dans la 
même plage de cellules remplies dans la même colonne.
S’il n’y a plus de cellule au-dessus contenant des données, active la dernière 
cellule de la colonne.

Ctrl+Début Active la cellule A1 de la même feuille.

Ctrl+Fin Active la cellule dans le coin inférieur droit de la zone rectangulaire qui contient 
des données dans la même feuille

Alt+PgSuiv Active la cellule située un écran à droite en faisant défiler la vue. Si cela n’est 
pas possible, active la dernière cellule de la ligne.

Alt+PgPrec Active la cellule située un écran à gauche en faisant défiler la vue. Si cela n’est 
pas possible, active la première cellule de la ligne.

Ctrl+PgSuiv Si le classeur a plusieurs feuilles, active la cellule à la même position dans la 
feuille située à droite dans la liste des onglets
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Combinaison 
de touches

Mouvement par rapport à la cellule active

Ctrl+PgPrec Si le classeur a plusieurs feuilles, active la cellule à la même position dans la 
feuille située à gauche dans la liste des onglets

Tab Active la cellule à droite sur la même ligne

Maj+Tab Active la cellule à gauche sur la même ligne

Entrée Active la cellule en dessous dans la même colonne (sauf changement par l’utili-
sateur)

Maj+Entrée Active la cellule au-dessus dans la même colonne (sauf changement par l’utili-
sateur)

Conseil

Utilisez Alt+→ ou Alt+← pour augmenter ou diminuer la largeur d’une colonne.

Personnaliser la touche Entrée

Vous pouvez personnaliser la direction dans laquelle la touche Entrée déplace l’activation de la 
cellule en ouvrant la page LibreOffice Calc – Général de la boîte de dialogue Options (Outils > 
Options dans la barre de menu). Sélectionnez la direction du mouvement dans la liste déroulante. 
Selon le fichier utilisé ou le type de données saisies, une direction différente peut être utile. La 
touche Entrée peut aussi être utilisée pour passer en et hors mode d’édition. Utilisez les deux 
premières options sous Paramètres de saisie (Figure 13) pour changer le paramétrage de la 
touche Entrée.

Figure 13 : Personnaliser la touche Entrée

Sélectionner des éléments dans un classeur

Sélectionner des cellules

Cellule individuelle

Faites un clic gauche dans la cellule. Vous pouvez vérifier votre sélection en regardant dans la 
zone de nom de la barre de formule (Figure 1 page 2).

Plage de cellules contiguës

Vous pouvez sélectionner une plage de cellules en utilisant le clavier ou la souris.
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Pour sélectionner une plage de cellules en faisant glisser la souris :

 1) Cliquez dans une cellule.

 2) Appuyez et gardez appuyé le bouton gauche de la souris.

 3) Déplacez la souris sur l’écran.

 4) Une fois que le bloc de cellules souhaité est en surbrillance, relâchez le bouton gauche de la
souris.

Pour sélectionner une plage de cellules sans faire glisser la souris :

 1) Cliquez dans la cellule qui sera un des coins de la plage de cellules.

 2) Déplacez la souris dans le coin opposé de la plage de cellules.

 3) Cliquez en appuyant sur la touche Maj.

Conseil

Vous pouvez aussi sélectionner une plage de cellules contiguës en commençant par cliquer 
sur le champ Mode de sélection de la barre d’État (Figure 3 page 6) et en choisissant Sé-
lection étendue avant de cliquer sur les coins opposés de la plage de cellules. Assurez-
vous de revenir à Sélection standard ou vous pourriez vous retrouvez en train d’étendre in-
volontairement une sélection de cellules.

Pour sélectionner une plage de cellules sans utiliser la souris :

 1) Sélectionnez la cellule qui sera un des coins de la plage de cellules.

 2) En gardant appuyée la touche Maj, utilisez les flèches du curseur pour sélectionner le reste 
de la plage.

Conseil

Vous pouvez également sélectionner directement une plage de cellules en utilisant la zone 
de nom de la barre de formule (Figure 1 page 2). Pour sélectionner une plage de cellules, 
saisissez la référence de cellule du coin supérieur gauche, suivi de deux points (:), et en-
suite de la référence de cellule du coin inférieur droit. Par exemple, pour sélectionner la 
plage qui va de A3 à C6, vous saisiriez A3: C6.

Plage de cellules non contiguës

 1) Sélectionnez la cellule ou la plage de cellules en utilisant une des méthodes ci-dessus.

 2) Déplacez le pointeur de la souris vers le début de la prochaine plage ou cellule individuelle.

 3) Maintenez appuyée la touche Ctrl et cliquez et faites glisser pour sélectionner une autre 
plage de cellules à ajouter à la première plage.

 4) Répétez autant que nécessaire.

La combinaison Ctrl+clic permet aussi de désélectionner certaines cellules ou plage de cel-
lules dans une sélection existante.
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Remarque

Certaines opérations ne peuvent pas s’appliquer à des cellules non contiguës. Il est, par 
exemple, impossible de copier une plage de cellules non contiguës.

Sélectionner des colonnes et des lignes

Colonne ou ligne individuelle

Pour sélectionner une colonne individuelle, cliquez sur l’en-tête de la colonne (voir Figure 1 page
2) ou utilisez le raccourci clavier Ctrl+Espace pour sélectionner la colonne de la cellule active.

Pour sélectionner une ligne individuelle, cliquez sur l’en-tête de la ligne ou utilisez le raccourci cla-
vier Maj+Espace pour sélectionner la ligne de la cellule active.

Colonnes ou lignes multiples

Pour sélectionner plusieurs colonnes ou lignes contiguës :

 1) Cliquez sur l’en-tête de la première colonne ou ligne du groupe.

 2) Cliquez sur l’en-tête de la dernière colonne ou ligne du groupe en appuyant sur la touche 
Maj.

Pour sélectionner plusieurs colonnes ou lignes multiples non contiguës :

 1) Cliquez sur l’en-tête de la première colonne ou ligne du groupe.

 2) Cliquez sur les en-têtes de toutes les colonnes ou lignes à sélectionner en appuyant sur la 
touche Ctrl.

Feuille entière

Pour sélectionner la feuille entière, cliquez dans la petite boîte entre l’en-tête de colonne A et celui 
de ligne 1 (Figure 14). Vous pouvez également appuyer sur Ctrl+A ou Ctrl+Maj+Espace pour 
sélectionner la feuille entière ou sélectionner Édition > Tout sélectionner dans la barre de menu.

Figure 14 : Boîte Tout sélectionner

Sélectionner des feuilles

Vous pouvez sélectionner une ou plusieurs feuilles. Il peut être intéressant de sélectionner plu-
sieurs feuilles en même temps si vous voulez y effectuer des modifications en une seule fois.

Feuille individuelle

Cliquez sur l’onglet de la feuille que vous voulez sélectionner. L’onglet de la feuille active devient 
blanc dans le paramétrage par défaut de Calc (voir Figure 11 page 16).

Plusieurs feuilles contiguës

Pour sélectionner plusieurs feuilles contiguës :

 1) Cliquez sur l’onglet de la première feuille désirée.
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 2) Cliquez sur l’onglet de la dernière feuille à sélectionner en appuyant sur la touche Maj.

Tous les onglets entre ces deux feuilles deviennent blancs (avec le paramétrage par défaut). 
Toutes les actions que vous effectuerez affecteront désormais toutes les feuilles sélectionnées.

Plusieurs feuilles non contiguës

Pour sélectionner plusieurs feuilles non contiguës :

 1) Cliquez sur l’onglet de la première feuille désirée.

 2) Cliquez sur l’onglet de la dernière feuille à sélectionner en appuyant sur la touche Ctrl.

 3) Répétez autant que nécessaire.

Les onglets sélectionnés deviennent blancs (avec le paramétrage par défaut). Toutes les actions 
que vous effectuerez affecteront désormais toutes les feuilles sélectionnées.

Toutes les feuilles

Faites un clic droit sur l’un des onglets et choisissez Sélectionner toutes les feuilles dans le 
menu contextuel.

Pour désélectionner

Pour revenir au fonctionnement par défaut avec une seule feuille sélectionnée, il suffit de cliquer 
sur l’onglet d’une feuille non sélectionnée. Si toutes les feuilles sont sélectionnées, faites un 
Ctrl+clic sur un des onglets.

Remarque

Si une couleur d’onglet a été définie pour une feuille, lorsque cette feuille est sélectionnée, 
la couleur n’apparaît qu’en bas de l’onglet et le reste de la zone devient blanc.

! Attention

Une fois les modifications effectuées sur les différentes feuilles, pensez à revenir à une 
seule feuille sélectionnée, sinon vos modifications continueront à s’appliquer à toutes les 
feuilles. Pour cela, cliquez sur l’onglet d’une feuille non sélectionnée.

Masquer et afficher des feuilles

Vous voudrez peut-être parfois cacher le contenu d’une feuille pour éviter qu’il soit accidentelle-
ment modifié ou parce qu’il n’est pas important de l’afficher.

Pour masquer une ou plusieurs feuilles, sélectionnez-les comme indiqué ci-dessus, faites un clic 
droit sur une des feuilles sélectionnées et choisissez Masquer la feuille dans le menu contextuel.

Pour afficher les feuilles masquées, faites un clic droit sur un onglet et choisissez Afficher les 
feuilles… dans le menu contextuel. Une boîte de dialogue s’ouvre avec la liste des feuilles mas-
quées. Sélectionnez-y les feuilles à afficher puis cliquez sur OK.

Remarque

LibreOffice Calc ne vous permet pas de masquer la dernière feuille visible.
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Actions sur les colonnes et les lignes

Insérer des colonnes et des lignes

Remarque

Les cellules des nouvelles colonnes ou lignes sont formatées comme les cellules correspon-
dantes de la colonne ou de la ligne au-dessus ou à gauche des nouvelles colonnes ou 
lignes insérées.

Colonne ou ligne individuelle

Avec le menu Feuille :

 1) Sélectionnez la cellule, colonne ou ligne où vous voulez insérer la nouvelle colonne ou ligne.

 2) Sélectionnez soit Feuille > Insérer des colonnes > Colonnes de gauche ou Colonnes de 
droite soit Feuille > Insérer des lignes > Lignes au-dessus ou Lignes en dessous dans 
la barre de menu.

Avec la souris :

 1) Sélectionnez la colonne ou la ligne où vous voulez insérer la nouvelle colonne ou ligne.

 2) Faites un clic droit sur l’en-tête de colonne ou de ligne.

 3) Choisissez Insérer des colonnes à gauche, Insérer des colonnes à droite, Insérer des 
lignes au-dessus ou Insérer des lignes au-dessous dans le menu contextuel.

Colonnes ou lignes multiples

Les colonnes ou lignes multiples peuvent être insérées en une fois plutôt qu’une par une.

 1) Mettez en surbrillance le nombre voulu de colonnes ou de lignes : cliquez sur l’en-tête de la 
première puis faites glisser la souris sur les en-têtes en gardant appuyé le bouton gauche.

 2) Procédez comme pour insérer une seule colonne ou ligne ci-dessus.

Supprimer des colonnes et des lignes

Les colonnes et les lignes peuvent être supprimées individuellement ou par groupes.

Colonne ou ligne individuelle

Une colonne ou ligne individuelle peut être supprimée en utilisant la souris :

 1) Sélectionnez une cellule dans la colonne ou la ligne à supprimer.

 2) Choisissez Feuille > Supprimer des cellules dans la barre de menu ou faites un clic droit et
choisissez Supprimer dans le menu contextuel.

 3) Cochez l’option dont vous avez besoin dans la boîte de dialogue Supprimer des cellules (Fi-
gure 15).
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Figure 15 : La boîte de dialogue Supprimer des cellules
Vous pouvez aussi

 1) Cliquer sur l’en-tête de la colonne ou de la ligne pour la sélectionner.

 2) Sélectionner Supprimer des colonnes ou Supprimer des lignes dans le menu Feuilles ou
dans le menu contextuel.

Colonnes ou lignes multiples

Les colonnes ou lignes multiples peuvent être supprimées en une fois plutôt qu’une par une.

 1) Mettez en surbrillance le nombre voulu de colonnes ou de lignes (voir « Colonnes ou lignes
multiples » page 20 pour plus d’information).

 2) Procédez comme pour supprimer une seule colonne ou ligne comme ci-dessus.

Conseil

Au lieu de supprimer une ligne ou une colonne, vous pouvez souhaiter supprimer les conte-
nus des cellules, mais garder la ligne ou la colonne vide. Voir le chapitre 2 du guide Calc 
(Saisir, modifier et formater les données) pour instructions.

Actions sur les feuilles

Insérer de nouvelles feuilles

Il y a plusieurs façons d’insérer une nouvelle feuille. La méthode la plus rapide est de cliquer sur le
bouton Ajouter une feuille  (voir Figure 11). Elle insère une nouvelle feuille après la dernière, 
sans ouvrir la boîte de dialogue Insérer une feuille. Les méthodes suivantes ouvrent la boîte de 
dialogue Insérer une feuille (Figure 16) où vous pouvez insérer plus d’une feuille, renommer la 
feuille, insérer la feuille ailleurs dans la séquence ou choisir une feuille dans un fichier.

Sélectionnez les feuilles près desquelles la nouvelle feuille va être insérée. Puis utilisez l’une des 
options suivantes.

• Choisissez Feuille > Insérer une feuille dans la barre de menu.

• Faites un clic droit sur l’onglet près duquel vous voulez insérer la nouvelle feuille ou dans 
l’espace vide après les onglets et choisissez Insérer une feuille dans le menu contextuel.

• Cliquez sur un espace vide à la fin de la ligne des onglets.

Actions sur les feuilles | 23



Figure 16 : La boîte de dialogue Insérer une feuille

Conseil

Vous pouvez fixer le nombre de feuilles des nouveaux documents en ouvrant la page 
LibreOffice Calc – Par défaut de la boîte de dialogue Options (Outils > Options). Par dé-
faut, une seule feuille de calcul est créée lors de l’ouverture d’un nouveau document.

Déplacer et copier des feuilles

Vous pouvez déplacer ou copier des feuilles dans le même classeur par glisser/déposer ou en utili-
sant la boîte de dialogue Déplacer/copier la feuille. Pour déplacer ou copier une feuille dans un 
autre classeur, vous devez utiliser cette boîte de dialogue.

Par glisser-déposer

Pour déplacer une feuille à une position différente dans le même classeur, cliquez et maintenez le 
bouton appuyé sur l’onglet de la feuille et tirez-le à sa nouvelle position avant de relâcher le bou-
ton.

Pour copier une feuille dans le même classeur, cliquez sur l’onglet de la feuille et tirez-le à sa nou-
velle position en maintenant la touche Ctrl appuyée (la touche Option sur Mac) avant de relâ-
cher le bouton de la souris. Le pointeur de la souris peut changer et comporter un signe plus selon 
la configuration de votre système d’exploitation.

Figure 17 : Faire glisser une feuille pour la déplacer
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En utilisant une boîte de dialogue

Utilisez la boîte de dialogue Déplacer/copier la feuille (Figure
18) pour spécifier exactement si vous voulez déplacer ou co-
pier la feuille dans le même classeur ou dans un autre, indi-
quer sa position dans le classeur et son nom.

 1) Dans le document en cours, sélectionnez Déplacer/
copier la feuille dans le menu contextuel ou dans le
menu Feuille de la barre de menu.

 2) Dans la section Action, cochez celle que vous désirez
effectuer.

 3) Choisissez le classeur où vous désirez placer la feuille
dans la liste déroulante Vers le document. Cela peut
être le même classeur, un autre classeur déjà ouvert
ou un nouveau classeur.

 4) Définissez dans Insérer avant la position où vous vou-
lez placer la feuille.

 5) Tapez un nom dans la boîte de texte Nouveau nom si
vous voulez renommer la feuille en la déplaçant ou en
la copiant. Si vous ne précisez pas de nom, Calc en
crée un par défaut (Feuille 2, Feuille 3, etc.).

 6) Cliquez sur OK pour confirmer l’opération et fermer la boîte de dialogue.

! Attention

Si vous choisissez comme document de destination un autre classeur ouvert ou - nouveau 
document –, cela peut créer des conflits pour les formules liées à d’autres feuilles du docu-
ment d’origine. Si vous déplacez involontairement une feuille, vous pouvez y remédier en 
déplaçant ou copiant la feuille à son emplacement d’origine.

Supprimer des feuilles

Feuille individuelle

Choisissez Supprimer la feuille… dans le menu contextuel, ou dans le menu Feuille de la barre 
de menu. Dans tous les cas, un avertissement vous demandera si vous voulez supprimer la feuille 
définitivement. Cliquez sur Oui.

Feuilles multiples

Pour supprimer plusieurs feuilles, sélectionnez-les comme décrit auparavant (page 20), puis choi-
sissez Supprimer la feuille… dans le menu contextuel, ou dans le menu Feuille de la barre de 
menu. Cliquez sur Oui pour confirmer la suppression.

Renommer des feuilles

Le nom par défaut d’une nouvelle feuille est FeuilleX, où Feuille est le préfixe défini dans Outils > 
Options > LibreOffice Calc > Par défaut et X est un numéro. Si cela convient pour un petit clas-
seur avec seulement quelques feuilles, cela devient moins lisible lorsqu’il y en a beaucoup.
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Pour donner à une feuille un nom plus significatif, vous pouvez :

• saisir le nom dans la zone de saisie Nom (Figure 16 page 24) quand vous créez la feuille 
avec la boîte de dialogue Insérer une feuille ;

• faire un clic droit sur l’onglet et choisir Renommer la feuille dans le menu contextuel ; rem-
placer le nom existant par un nouveau.

• faire Alt+Clic sur l’onglet pour y modifier directement le nom ;

• faire un double clic sur l’onglet pour ouvrir la boîte de dialogue Renommer la feuille.

Remarque

Les noms de feuilles doivent être uniques dans le classeur et commencer par une lettre ou 
un chiffre ; les autres caractères, y compris l’espace ne sont pas autorisés. La suite du nom 
ne doit être constituée que de lettres, de chiffres, d’espaces et de caractères de souligne-
ment (_).
Tenter de donner un nom incorrect à une feuille produit un message d’erreur.

Affichage de Calc

Modifier l’affichage du document

Utilisez la fonction zoom pour afficher plus ou moins de cellules dans la fenêtre pendant que vous 
travaillez sur un classeur. Pour plus de renseignements sur le zoom, voyez le Chapitre 1, Présen-
tation de LibreOffice dans ce guide.

Fixer les lignes et les colonnes

Le fait de fixer verrouille un certain nombre de lignes en haut d’un classeur et un certain nombre 
de colonnes à sa gauche ou les deux à la fois. Quand vous vous déplacez ensuite dans une 
feuille, les cellules des lignes et colonnes figées restent toujours visibles.

La Figure 19 montre quelques lignes et colonnes fixées. Le trait horizontal plus épais entre les 
lignes 4 et 14 ainsi que le trait vertical entre les colonnes B et G indiquent que les lignes 1 à 4 et 
les colonnes A et B sont figées. Les lignes de 5 à 13 et les colonnes de C à F ont été décalées 
hors de l’affichage.

Figure 19 : Lignes et colonnes fixées
Comment fixer des lignes ou des colonnes

 1) Cliquer dans la cellule immédiatement sous les lignes et à droite des colonnes que vous vou-
lez fixer.

 2) Sélectionner Affichage > Fixer des cellules > Fixer lignes et colonnes dans la barre de 

menu ou cliquer sur l’icône Fixer lignes et colonnes  dans la barre d’outils Standard. 
Une ligne plus épaisse apparaît entre les lignes et les colonnes fixées et libres.
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Si vous souhaitez fixer uniquement la première ligne ou la première colonne, il vous suffit de sélec-
tionner Affichage > Fixer des cellules > Fixer la première ligne ou Fixer la première colonne, 
sans qu’aucune sélection ou positionnement particulier ne soit nécessaire.

Comment libérer les lignes et les colonnes figées

Pour libérer les lignes ou les colonnes, sélectionnez Affichage > Fixer des cellules > Fixer 

lignes et colonnes dans la barre de menu ou cliquez sur l’icône Fixer lignes et colonnes  
dans la barre d’outils Standard. Les traits plus épais qui marquent les lignes et colonnes fixées dis-
paraîtront et les lignes et colonnes libres qui étaient masquées réapparaîtront.

Scinder l’écran

Une autre façon de changer l’affichage consiste à scinder la fenêtre. L’écran peut être scindé hori-
zontalement, verticalement, ou les deux. Vous pouvez par conséquent avoir jusqu’à quatre por-
tions de la feuille affichées en même temps comme sur la Figure 20. À la différence de la com-
mande Fixer lignes colonnes, scinder l’écran permet de conserver un ascenseur dans chaque par-
tie de la fenêtre.

Pourquoi scinder la fenêtre ? Imaginez, par exemple, un grand classeur dans lequel une des cel-
lules contient un nombre qui est utilisé par trois formules dans d’autres cellules. En scindant 
l’écran, vous pouvez positionner la cellule contenant le nombre dans une section et chacune des 
cellules avec formule dans les autres sections. Vous pouvez alors changer le nombre dans la cel-
lule et voir comment cela affecte les résultats de chacune des formules.

Figure 20 : Exemple d’écran scindé

Comment scinder l’écran horizontalement ou verticalement

 1) Cliquez sur

─ l’en-tête de la ligne sous celles où vous voulez scinder l’écran horizontalement,

─ l’en-tête de la colonne à droite de celles où vous voulez scinder l’écran verticalement.

 2) Sélectionnez Affichage > Scinder la fenêtre dans la barre de menu. Une ligne plus épaisse
apparaît entre les lignes et les colonnes qui délimitent le partage (voir Figure 20).

Vous pouvez aussi (voir Figure 21)

• Tirer la nouvelle bordure de fenêtre horizontale sous la ligne où vous voulez placer le par-
tage horizontal.

• Tirer la nouvelle bordure de fenêtre verticale à droite de la colonne où vous voulez placer le 
partage vertical.
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Tirez ici pour partager la fenêtre verticalement

Tirez ici pour partager la fenêtre horizontalement

Figure 21 : Partage interactif de la fenêtre

Comment scinder l’écran horizontalement et verticalement

 1) Sélectionnez la cellule immédiatement sous les lignes et immédiatement à droite des co-
lonnes où vous voulez scinder l’écran.

 2) Sélectionnez Affichage > Scinder la fenêtre dans la barre de menu. Une ligne plus épaisse
apparaît entre les lignes et les colonnes qui délimitent le partage (voir Figure 20).

Comment supprimer le partage de l’écran

Pour annuler un partage de l’écran,

• replacez les bordures de fenêtres scindées à leur position aux extrémités des barres de défi-
lement (Figure 21)

• sélectionnez Affichage > Scinder la fenêtre dans la barre de menu pour décocher l’option.

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent être faites en utilisant le clavier.

Saisir des nombres

Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie prin-
cipale du clavier, soit du pavé numérique. Par défaut, les nombres sont alignés à droite.

Nombres négatifs

Pour saisir un nombre négatif, tapez le signe moins (–) devant celui-ci ou placez-le entre paren-
thèses, par exemple (1234).

Le signe plus (+) n’est pas nécessaire pour les nombres positifs.

Zéros non significatifs

Si vous désirez conserver un nombre minimum de chiffres dans une cellule contenant un nombre 
avec un format numérique défini, par exemple 1234 et 0012, des zéros non significatifs doivent 
être ajoutés à l’aide d’une des méthodes suivantes :

Méthode 1

 1) La cellule étant active, ouvrez la boîte de dialogue Formatage des cellules (Figure 22) par 
l’une des méthodes suivantes :

─ faites un clic droit dans la cellule et sélectionnez Formater des cellules… dans le menu 
contextuel,

─ sélectionnez Format > Cellules… dans la barre de menu,
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─ utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Nombre dans la liste Catégo-
rie.

 3) Dans Options > Zéros non significatifs, saisissez le nombre minimum de caractères né-
cessaires. Par exemple, pour quatre caractères, tapez 4. Tout nombre ayant moins de quatre
chiffres sera précédé de zéros non significatifs, par exemple 12 deviendra 0012.

 4) Cliquez sur OK. Le nombre saisi conserve son format numérique et toute formule utilisée 
dans le classeur traitera l’entrée comme un nombre dans les fonctions des formules.

Figure 22: L’onglet Nombres de la boîte de dialogue Formatage des cellules.

Méthode 2

 1) Sélectionnez la cellule.

 2) Dans le volet latéral (Affichage > Volet latéral), ouvrez l’onglet Propriétés puis le panneau 
Format numérique (cliquez sur le + ou ˅ pour ouvrir celui-ci).

 3) Choisissez Nombre dans la liste déroulante située sous le titre du panneau Format numé-
rique.

 4) Tapez 4 dans la boîte Zéros non significatifs. Le format est immédiatement appliqué.
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Figure 23: Définir le nombre de zéros non significatifs

Si un nombre est saisi avec des zéros non significatifs, par exemple 01481, sans que le paramé-
trage des zéros non significatifs ait été fait, par défaut Calc va automatiquement les supprimer. 
Pour les préserver :

 1) Tapez une apostrophe (‘) avant le nombre, par exemple ‘01481.

 2) Activez une autre cellule. L’apostrophe est automatiquement supprimée, les zéros non signi-
ficatifs sont conservés et le nombre est converti en texte aligné à gauche.

Nombres sous forme de texte

Les nombres peuvent aussi être saisis sous forme de texte grâce à l’une des méthodes suivantes :

Méthode 1

 1) La cellule étant sélectionnée, ouvrez la boîte de dialogue Formatage des cellules (Figure 22)
par l’une des méthodes suivantes :

─ faites un clic droit sur la cellule et sélectionnez Formater les cellules… dans le menu 
contextuel,

─ sélectionnez Format > Cellules… dans la barre de menu,

─ utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Texte dans la liste Catégorie.

 3) Cliquez sur OK. Le nombre saisi est converti en texte et aligné par défaut à gauche.

Méthode 2

 1) Sélectionnez la cellule.

 2) Dans le volet latéral (Affichage > Volet latéral), ouvrez l’onglet Propriétés puis le panneau 
Format numérique (cliquez sur le + ou ˅ pour ouvrir celui-ci).

 3) Choisissez Texte dans la liste déroulante située sous le titre du panneau Format numé-
rique. Le formatage est immédiatement appliqué à la cellule.

 4) Cliquez sur la cellule. Saisissez le nombre et activez une autre cellule pour que la donnée 
soit mise en forme.

30 | Débuter avec Calc



Remarque

Par défaut, tout nombre mis en forme comme texte dans un classeur sera traité comme un 
zéro par toutes les formules utilisées. Les fonctions ignorent les entrées textuelles dans les 
formules.

Cette fonctionnalité peut être changée dans la boîte de dialogue Options (Outils > Options 
dans la barre de menu), à la page LibreOffice Calc – Formule en cochant Personnalisé 
(conversion de texte en nombres, et autres) dans la section Paramètres de calcul détaillés
puis en sélectionnant le traitement approprié dans la boîte de dialogue Paramètres de calcul
détaillés qui s’ouvre en cliquant sur le bouton Détails…

Saisir des textes

Cliquez dans la cellule et tapez le texte. Les textes sont alignés à gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours à la ligne
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur le bouton Étendre la barre Formule  si-
tué à l’extrémité droite de cette zone. Elle offre alors plusieurs lignes (Figure 24). Cliquez à nou-
veau sur le bouton  pour revenir à la zone de saisie initiale.

Figure 24 : Zone de saisie multi-ligne

Saisir des dates et des heures

Sélectionnez la cellule et tapez la date ou l’heure.

Vous pouvez séparer les éléments de la date avec un slash (/) ou un tiret (–) ou utiliser un texte 
comme 10 octobre 2013. Calc reconnaît plusieurs formats de date ; le format utilisé par Calc s’ap-
pliquera automatiquement.

Vous pouvez séparer les éléments de l’heure avec des deux-points comme 10:43:45. Le format 
horaire utilisé par Calc s’appliquera automatiquement.

Pour modifier le format de date ou d’heure utilisé par Calc, appliquez une des méthodes suivantes.

Méthode 1

 1) La cellule étant sélectionnée, ouvrez la boîte de dialogue Formatage des cellules (Figure 22)
par l’une des méthodes suivantes :

─ faites un clic droit sur la cellule et sélectionnez Formater les cellules… dans le menu 
contextuel,

─ sélectionnez Format > Cellules… dans la barre de menu,
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─ utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Date ou Heure dans la liste 
Catégorie.

 3) Choisissez le format que vous désirez utiliser dans la liste Format.

 4) Cliquez sur OK.

Méthode 2

 1) Sélectionnez la cellule.

 2) Dans le volet latéral (Affichage > Volet latéral), ouvrez l’onglet Propriétés puis le panneau 
Format numérique (cliquez sur le + ou ˅ pour ouvrir celui-ci).

 3) Choisissez Date ou Heure dans la liste déroulante située sous le titre du panneau Format 
numérique.

 4) Cliquez sur le bouton Plus d’options ( ) dans la barre de titre du panneau pour ouvrir la 
boîte de dialogue Formatage des cellules (Figure 22).

 5) Choisissez le format que vous désirez utiliser dans la liste Format.

 6) Cliquez sur OK.

Plus d’options

Figure 25 : Format Date

Les formats de saisie des dates reconnus par Calc peuvent être définis dans l’option Motifs d’ac-
ceptation de date dans la page Paramètres linguistiques – Langues, de la boîte de dialogue Op-
tions (Outils > Options dans la barre de menu) avec les notations suivantes : D pour le jour, M 
pour le mois et Y pour l’année.

Conseil

Les raccourcis clavier Ctrl+; et Maj+Ctrl+; permettent de saisir la date et l’heure cou-
rante dans la cellule, respectivement formatées en date et en heure. La saisie est effectuée 
sous forme de valeur. Comme ce ne sont pas des fonctions ou des champs, les données ne 
sont pas actualisées par la suite.

Options d’autocorrection

Calc applique automatiquement plusieurs changements durant la saisie de données, à moins que 
vous n’ayez désactivé cette fonction. Vous pouvez également annuler immédiatement chaque 
changement automatique avec Ctrl+Z ou en revenant manuellement à la modification pour rem-
placer l’autocorrection par ce que vous désirez voir vraiment.
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Pour modifier les options d’autocorrections, sélectionnez Outils > Options d’autocorrection dans
la barre de menu pour ouvrir la boîte de dialogue AutoCorrection (Figure 26).

Remplacer

Éditez la table de remplacement pour la correction automatique ou le remplacement de mots ou 
d’abréviations dans votre document.

Exceptions

Précisez les abréviations ou combinaisons de lettres que vous ne voulez pas que LibreOffice cor-
rige automatiquement.

Options

Sélectionnez les options pour la correction des erreurs en cours de frappe puis cliquez sur OK.

Options linguistiques

Spécifiez les options d’autocorrection des guillemets et d’autres options particulières à la langue 
utilisée pour les textes.

Réinitialiser

En cliquant sur ce bouton, vous rétablissez les valeurs par défaut définies par LibreOffice.

Figure 26 : La boîte de dialogue AutoCorrection
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! Attention

Les options d’AutoCorrection sont communes à tous les modules : les modifier dans Calc, 
les modifiera aussi dans Writer ou Impress par exemple.

Désactiver les modifications automatiques

Changements de l’AutoCorrection

Voir « Options d’autocorrection » ci-dessus.

AutoSaisie

Quand vous tapez du texte dans une cellule, Calc suggère automatiquement une occurrence trou-
vée dans la même colonne. Pour activer ou désactiver l’AutoSaisie, affichez ou enlevez la coche 
devant Outils > AutoSaisie.

Conversion automatique des dates

Calc convertit automatiquement certaines saisies en dates. Pour s’assurer qu’une saisie qui res-
semble à une date est considérée comme un texte, formatez la cellule en texte ou tapez une apos-
trophe au début de la saisie.

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit plu-
sieurs outils pour en alléger certaines corvées.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d’une cellule dans une 
autre avec la souris. Beaucoup de personnes trouvent également utile l’AutoSaisie. Calc recèle 
également plusieurs autres outils pour la saisie automatique, plus particulièrement pour les tâches 
répétitives. Ce sont l’outil Remplir, les listes de sélection et la possibilité de saisir de l’information 
dans plusieurs feuilles du document.

Utiliser l’outil Remplir dans les cellules

L’outil Remplir de Calc permet de dupliquer le contenu existant ou de créer une suite dans une 
suite de cellules de votre classeur.

 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.

 2) Tirez la souris dans n’importe quelle direction ou appuyez sur la touche Maj et cliquez sur la 
dernière cellule que vous voulez remplir.

 3) Sélectionnez Feuille > Remplir les cellules dans la barre de menu puis la direction dans la-
quelle vous voulez copier ou créer les données (Vers le bas, A gauche, Vers le haut, A 
gauche), Séries, ou Nombre aléatoire dans le sous-menu.

Vous pouvez aussi utiliser un raccourci pour remplir les cellules (Figure 27).

 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.

 2) Déplacez le pointeur sur le petit carré en bas à droite de la cellule sélectionnée. Le pointeur 
change de forme.
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 3) Cliquez et tirez dans la direction où vous désirez remplir les cellules. Si la cellule initiale 
contenait du texte, celui-ci sera automatiquement recopié. Si la cellule initiale contenait un 
nombre (seul ou en fin de chaîne), une suite croissante sera créée si vous tirez vers la droite
ou vers le bas, décroissante si vous tirez vers la gauche ou vers le haut.

 4) Si la cellule initiale contient un nombre et que vous appuyez simultanément sur la touche 
Ctrl, son contenu est recopié au lieu d’être incrémenté ou décrémenté.

Figure 27 : Utiliser l’outil Remplir

Utiliser des séries de remplissage

Quand vous choisissez Feuille > Remplir les cellules > Série… dans la barre de menu, la boîte 
de dialogue Remplir la série s’ouvre (Figure 28). Vous pouvez y sélectionner le type de série que 
vous voulez.

Figure 28 : La boîte de dialogue Remplir la série

• La section Direction définit la direction dans laquelle la suite est créée.

─ L’option Bas crée une suite du haut vers le bas de la zone de cellules sélectionnées en 
utilisant l’incrément défini jusqu’à la valeur finale.

─ L’option Droite crée une suite de gauche à droite dans la zone de cellules sélectionnées 
en utilisant l’incrément défini jusqu’à la valeur finale.

─ L’option Haut crée une suite du bas vers le haut dans la zone de cellules sélectionnées en
utilisant l’incrément défini jusqu’à la valeur finale.

─ L’option Gauche crée une suite de droite à gauche dans la zone de cellules sélectionnées 
en utilisant l’incrément défini jusqu’à la valeur finale.

• La section Type de séries définit le type de la suite.
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─ L’option Arithmétique crée une suite arithmétique en ajoutant l’incrément à la valeur pré-
cédente jusqu’à la valeur finale définie.

─ L’option Géométrique crée une suite géométrique en multipliant la valeur précédente par 
l’incrément jusqu’à la valeur finale définie.

─ L’option Date crée une suite de dates en ajoutant l’incrément à la date précédente jusqu’à 
la date finale définie, compte tenu de l’unité de temps définie.

─ L’option Remplir automatiquement crée une suite directement dans la feuille. La fonction 
de remplissage automatique prend en compte les listes personnalisées. Par exemple, si 
vous saisissez janvier dans la première cellule, la suite est complétée à partir de la liste 
définie dans la page LibreOffice Calc – Listes de tri de la boîte de dialogue Option (Outils 
> Options dans la barre de menu )(Figure 29). Le remplissage automatique essaie de dé-
terminer les valeurs d’une suite en définissant un incrément arithmétique. Par exemple, 
une suite numérique commençant par 1, 3, 5 est automatiquement complétée par 7, 9, 11,
13 ; une suite de date commençant par 01/01/99 et 16/01/99 sera complétée par des 
dates espacées de quinze jours.

• La section Unité de temps vous permet de spécifier l’unité de temps désirée. Elle n’est ac-
tive que si l’option Date a été cochée dans la section Type de série.

─ L’option Jour crée une suite utilisant les sept jours de la semaine.

─ L’option Jour de la semaine crée une suite utilisant cinq jours ouvrables (du lundi au ven-
dredi).

─ L’option Mois crée une suite dont l’incrément est en mois.

─ L’option Année crée une suite dont l’incrément est en années.

• Le champ Valeur initiale définit la valeur initiale de la suite. Utilisez des nombres, des dates 
ou des heures. 

• Le champ Valeur finale définit la valeur finale de la suite. Utilisez des nombres, des dates ou 
des heures.

• Le champ Incrément définit la valeur par laquelle les éléments de la suite du type sélectionné
sont modifiés à chaque étape. La valeur ne peut être saisie que si le type de série arithmé-
tique, géométrique ou date a été sélectionné.

Définir une liste de remplissage

Pour définir vos propres listes de remplissage :

 1) Sélectionnez Outils > Options dans la barre de menu pour ouvrir la boîte de dialogue Op-
tions, puis ouvrez la page LibreOffice Calc – Listes de tri (Figure 29). Celle-ci affiche les 
suites précédemment définies dans la zone Listes à gauche et le contenu de la liste sélec-
tionnée dans la zone Entrées.

 2) Cliquez sur Nouveau et la boîte Entrées se vide.

 3) Tapez la suite de la nouvelle liste dans la boîte Entrées (une valeur par ligne).

 4) Cliquez sur Ajouter et la nouvelle liste apparaît désormais dans la zone Listes.

 5) Cliquez sur OK pour enregistrer la nouvelle liste.
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Figure 29 : La boîte de dialogue Listes de tri

Définir une liste de remplissage à partir d’une plage d’une feuille

Vous pouvez définir une liste de remplissage à partir d’une plage de valeurs textuelles.

 1) Sélectionnez la plage qui contient les valeurs de texte que vous désirez utiliser comme liste 
de remplissage.

 1) Sélectionnez Outils > Options dans la barre de menu pour ouvrir la boîte de dialogue Op-
tions, puis ouvrez la page LibreOffice Calc – Listes de tri (Figure 29).

 2) La plage sélectionnée se trouve dans le champ Copier la liste depuis. Cliquez sur Copier 
pour ajouter les valeurs aux listes de tri.

Utiliser les listes de sélection

Les listes de sélection sont disponibles uniquement pour des textes qui ont été déjà saisis dans la 
même colonne.

Pour utiliser une liste de sélection :

 1) Sélectionnez une cellule vide dans une colonne contenant déjà des entrées textuelles et ap-
puyez sur Alt+↓ (flèche bas) ou faites un clic droit et choisissez Liste de sélection dans le 
menu contextuel. Une liste déroulante apparaît et propose le contenu de toutes les cellules 
de la même colonne qui ont au moins un caractère de texte ou dont le format est défini 
comme texte. Ces textes sont triés par ordre alphabétique et ceux qui ont des occurrences 
multiples n’apparaissent qu’une seule fois.

 2) Cliquez sur l’entrée dont vous avez besoin pour que le texte s’insère dans la cellule sélec-
tionnée.
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Partager du contenu entre plusieurs feuilles

Il peut arriver que vous vouliez saisir la même information dans la même cellule de plusieurs 
feuilles, par exemple pour fixer des listes standard pour un groupe de personnes ou pour des orga-
nismes. Au lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une 
fois pour toutes les feuilles. Pour cela, 

 1) Choisissez Édition > Sélectionner > Sélectionner les feuilles…  dans la barre de menu 
pour ouvrir la boîte de dialogue Sélectionner des feuilles.

 2) Sélectionnez les feuilles où vous désirez que l’information soit répétée. Utilisez les touches 
Maj et Ctrl (Options sur Mac) pour sélectionner plusieurs feuilles.

 3) Cliquez sur OK pour sélectionner les feuilles dont les onglets changent de couleur.

 4) Saisissez l’information dans la feuille courante, elle sera répétée dans toutes les feuilles sé-
lectionnées.

Figure 30 : La boîte de dialogue Sélectionner des feuilles

! Attention

Cette technique écrase, sans aucun avertissement toute information qui se trouve déjà dans
les cellules des autres feuilles sélectionnées. Pour cette raison, quand vous avez fini, assu-
rez-vous de bien désélectionner toutes les feuilles sauf celle que vous voulez modifier. 
(Ctrl+clic sur un onglet pour sélectionner ou désélectionner la feuille.)

Valider le contenu des cellules

Quand vous créez des classeurs destinés à être utilisés par d’autres personnes, vous désirez 
peut-être vous assurer qu’elles saisissent des données valides ou appropriées à la cellule. Vous 
pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des don-
nées complexes ou rarement utilisées.

Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de don-
nées, mais elles sont limitées à des informations prédéfinies. Pour valider une nouvelle donnée 
saisie par un utilisateur, sélectionnez une cellule et choisissez Données > Validité sur la barre de 
menu pour définir le type de contenu qui peut être saisi dans cette cellule. Par exemple, une cel-
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lule peut recevoir uniquement une date ou un nombre entier, sans caractère alphabétique ni sépa-
rateur décimal ; ou bien encore une cellule ne doit pas être laissée vide.

Selon les paramètres choisis pour la validation, l’outil peut aussi définir l’intervalle des valeurs qui 
peuvent être saisies, et fournir des messages d’aide qui expliquent les règles de validation que 
vous avez paramétrées pour cette cellule (ce que les utilisateurs devraient faire s’ils saisissent un 
contenu incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l’ac-
cepter avec un avertissement, ou, si vous êtes très organisé, exécuter une macro si une valeur er-
ronée est saisie.

Pour plus d’informations sur cette fonctionnalité, voir le chapitre 2, Saisir, éditer et formater des 
données dans le Guide Calc.

Modifier les données

Supprimer les données d’une cellule

Supprimer seulement les données

Les données seules peuvent être supprimées dans une cellule sans en affecter le formatage. Cli-
quez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer les données et le formatage

Les données et le formatage peuvent être supprimés d’une cellule en une seule fois.

 1) Cliquez sur la cellule pour la sélectionner.

 2) Appuyez sur la touche Retour arrière (ou faites un clic droit et choisissez Effacer le 
contenu… dans le menu contextuel, ou sélectionne Feuille > Effacer des cellules… dans 
la barre de menu) pour ouvrir la boîte de dialogue Supprimer du contenu (Figure 31). Dans 
cette boîte de dialogue, plusieurs attributs de la cellule peuvent être supprimés. Pour tout 
supprimer dans une cellule (contenu et format), cochez l’option Tout supprimer.

Figure 31   : La boîte de dialogue Supprimer du contenu

Remplacer toutes les données dans une cellule

Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les 
anciennes données. Les nouvelles données conserveront le format des précédentes.
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Vous pouvez aussi cliquer dans la ligne de saisie de la barre de formule (Figure 1 page 2), puis 
faire un triple clic sur les données pour les sélectionner totalement avant de taper les nouvelles 
données.

Modifier les données dans une cellule

Il est parfois nécessaire de changer le contenu d’une cellule sans en supprimer tout le contenu, 
par exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit être changée en 
“Jean va partir demain.” 

Avec le clavier

 1) Cliquez dans la cellule désirée pour la sélectionner.

 2) Appuyez sur la touche F2 et le curseur sera placé à la fin de la cellule.

 3) Utilisez alors les flèches du clavier pour déplacer le curseur dans le texte de la cellule à la 
position où débute la modification.

 4) Appuyez sur la touche Entrée quand vous avez terminé pour enregistrer vos modifications.

Avec la souris

 1) Double-cliquez dans la cellule voulue (pour la sélectionner et placer le curseur à l’intérieur 
pour modification).

 2) Cliquez dans la cellule pour placer le curseur à l’endroit où vous désirez commencer les mo-
difications et effectuer celles-ci.

Ou

 1) Cliquez sur la cellule pour la sélectionner.

 2) Cliquez à l’intérieur de la ligne de saisie (Figure 1 page 2) à l’emplacement des modifications
à effectuer.

Quand vous avez terminé, cliquez hors de la cellule pour la désactiver et enregistrer vos modifica-
tions.

Formater les données

Remarque

Tous les paramétrages abordés dans cette section peuvent aussi être affectés à un style de 
cellule. Voir le chapitre 4, Utiliser les styles et les modèles, du Guide Calc pour plus d’infor-
mations.

Formater plusieurs lignes de texte

Des lignes de texte multiples peuvent être saisies dans une seule cellule en utilisant le renvoi à la 
ligne automatique ou des retours manuels à la ligne. Chaque méthode est utile dans différentes si-
tuations.
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Utiliser le retour à la ligne automatique

Méthode 1

Pour que le texte revienne à la ligne en fin de cellule,

 1) La cellule étant sélectionnée, ouvrez la boîte de dialogue Formatage des cellules (Figure 22)
par l’une des méthodes suivantes :

─ faites un clic droit sur la cellule et sélectionnez Formater les cellules… dans le menu 
contextuel,

─ sélectionnez Format > Cellules… dans la barre de menu,

─ utilisez le raccourci Ctrl+1 au clavier.

 2) Cliquez sur l’onglet Alignement (Figure 32),

Figure 32   : L’onglet Alignement de la boîte de dialogue Formatage des cellules.

 3) Dans la section Propriétés, cochez l’option Renvoi à la ligne automatique et cliquez sur OK. 
Le résultat est montré ci-dessous (Figure 33).

Figure 33 : Retour à la ligne automatique

Méthode 2

 1) Sélectionnez la cellule.
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 2) Dans le volet latéral (Affichage > Volet latéral), ouvrez l’onglet Alignement puis le panneau
Format numérique (cliquez sur le + ou ˅ pour ouvrir celui-ci).

 3) Cochez Ajuster le texte pour appliquer immédiatement le formatage.

Figure 34 : Formatage du retour à la ligne.

Utiliser les sauts de ligne manuels

Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur 
Ctrl+Entrée. Pour insérer un saut de ligne dans un texte déjà saisi, double-cliquez dans la cel-
lule à l’endroit où vous voulez faire un saut de ligne (il est aussi possible de cliquer dans la ligne de
saisie à l’endroit concerné) avant d’appuyer sur Ctrl+Entrée.

Quelle que soit la méthode (renvoi à la ligne automatique ou saut de ligne manuel), la hauteur de 
ligne est adaptée pour afficher toutes les lignes de la cellule, mais, en cas de saut de ligne manuel,
la largeur de cellule ne change pas. La Figure 35 montre le résultat de la saisie de deux sauts de 
ligne manuels après la première ligne de texte. Vous devez modifier manuellement la largeur de la 
cellule ou repositionner votre saut de ligne pour que votre texte ne déborde pas de la fin de la cel-
lule.

Figure 35   : Cellule avec sauts de ligne manuels

Ajuster le texte à la taille de la cellule

La taille de police des données d’une cellule peut être automatiquement ajustée pour remplir la 
cellule. Pour cela, cochez l’option Ajuster à la taille de la cellule dans la boîte de dialogue Forma-
tage des cellules (Figure 32) dans l’onglet Alignement. La Figure 36 montre le résultat. Cette boîte 
de dialogue est aussi accessible en cliquant sur le bouton Plus d’options dans la barre de titre du 
panneau Alignement de l’onglet Propriétés du volet latéral.

Figure 36 : Ajustement de la taille de police à la cellule
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Formater les nombres

Plusieurs formats de nombres différents peuvent être appliqués aux cellules en utilisant les icônes 
de la barre d’outils Formatage (Figure 37). Sélectionnez la cellule, puis cliquez sur l’icône corres-
pondante. Certaines icônes peuvent ne pas être visibles avec le réglage par défaut ; faites un clic 
droit sur une icône de la barre puis choisir Boutons visibles dans le menu contextuel et sélection-
nez les icônes à afficher.

Figure 37   : Icônes de formats de nombres dans la barre d’outils Formatage. De gauche à droite  :
général, monnaie, pourcentage, nombre, date, scientifique, ajouter une décimale, supprimer une

décimale.

Pour plus de contrôle ou pour sélectionner d’autres formats de nombres, utilisez l’onglet Nombres 
(Figure 38) de la boîte de dialogue Formatage des cellules :

• appliquez aux données l’un des types de la liste Catégorie ;

• paramétrez le nombre de décimales et de zéros non significatifs dans Options ;

• saisissez une description du format personnalisée.

Le champ Langue détermine les paramètres locaux pour les différents formats comme l’ordre 
dans les dates et le symbole de l’unité monétaire.

Figure 38   : La boîte de dialogue Formatage des cellules, onglet Nombres

Certains formats numériques sont accessibles depuis le panneau Formats numériques du Volet 
latéral dans l’onglet Propriétés (Figure 39). Cliquez sur le bouton Plus d’options  pour ouvrir la
boîte de dialogue Formatage des cellules décrite ci-dessus.

Formater les données | 43



Figure 39 : Icônes de formats numériques dans le panneau Format numérique du volet latéral

Formater la police

Pour choisir rapidement la police utilisée dans une cellule :

 1) Sélectionnez la cellule

 2) Cliquez sur la flèche à droite du champ Nom de police dans la barre d’outils Formatage (Fi-
gure 40) et choisissez une police dans la liste.

 3) Pour choisir la taille de la police, cliquez sur la flèche près du champ Taille de police dans la
barre d’outils Formatage et choisissez une taille dans la liste.

Figure 40 : Mise en forme du texte dans la barre d’outils Formatage

 4) Pour d’autres attributs, vous pouvez utiliser les boutons Gras ( ), Italique ( ) ou Souli-
gnage ( ).

 5) Pour modifier l’alignement horizontal du paragraphe, cliquez sur un des quatre boutons d’ali-
gnement (Gauche , Centré , Droite , Justifié )1. Vous trouverez des choix supplé-
mentaires dans l’onglet Alignement la boîte de dialogue Formatage des cellules (raccourci 
Ctrl+1) (Figure 32) en déroulant la liste Horizontal de la section Alignement du texte.

 6) Pour modifier l’alignement vertical du texte dans la cellule, cliquez sur un des trois boutons 
Aligner en haut ( ), Centrer verticalement ( ) et Aligner en bas ( ) de la barre d’outils 
Formatage1, Vous disposerez de choix supplémentaires dans l’onglet Alignement la boîte de 
dialogue Formatage des cellules (raccourci Ctrl+1) (Figure 32) et sélectionnez une option 
dans la liste déroulante Vertical de la section Alignement du texte.

 7) Pour choisir une couleur de police, cliquez sur la flèche à droite de l’icône Couleur de police
 pour afficher la palette des couleurs. Cliquez sur la couleur voulue.

 8) Le menu Format offre aussi quelques moyens pour formater rapidement le texte des cellules 
(Figure 41).

L’onglet Propriétés du Volet latéral possède cinq panneaux, Styles, Caractère, Alignement, For-
mat Numérique et Apparence de la cellule qui contiennent tous les contrôles de mise en forme de 
la barre d’outils Formatage.

Vous pouvez aussi utiliser le bouton Plus d’options  de l’un des panneaux du Volet latéral pour 
ouvrir la boîte de dialogue Formatage des cellules.

Pour spécifier la langue de la cellule (utile pour permettre à plusieurs langues d’exister dans un 
même document et d’être vérifiées correctement (orthographe)), utilisez l’onglet Police de la boîte 
de dialogue Formatage des cellules.

Utilisez l’onglet Effets de caractère de la boîte de dialogue Formatage des cellules pour définir 
d’autres propriétés de la police. Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modèles 
dans Calc, pour plus d’informations.

1 Ces boutons sont aussi disponibles dans le panneau Alignement de l’onglet Propriétés du volet 
latéral.
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Figure 41 ; Formatage direct grâce au menu Format.

Formater les bordures des cellules

Pour formater les bordures d’une cellule ou d’un groupe de cellules sélectionnées, cliquez sur 
l’icône Bordures  de la barre d’outils Formatage et choisissez une des options proposées par la
palette.

Pour choisir rapidement un style de ligne et une couleur pour les bordures d’une cellule, cliquez 
sur la petite flèche près des icônes Style de bordure  et Couleur de bordure  dans la barre 
d’outils Formatage pour afficher une palette Style de bordure ou Couleur de bordure. Si ces icônes
ne sont pas affichées dans la barre d’outils Formatage, faites un clic droit sur la barre puis choisis-
sez Boutons visibles et sélectionnez les icônes à afficher. Dans chaque cas, une palette de choix
est affichée.

Le panneau Apparence de cellule dans l’onglet Propriétés du volet latéral contient les contrôles 
Bordures de cellule, Style de ligne et Couleur de ligne.

Pour des contrôles supplémentaires, comme l’espacement entre les bordures de la cellule et le 
texte, utilisez l’onglet Bordures de la boîte de dialogue Formatage des cellules. Vous pouvez éga-
lement y définir un style d’ombre.

Cliquer sur le bouton Plus d’options  de la barre de titre Apparence de cellule ou sur Plus 
d’options dans la liste déroulante style de ligne de ce panneau, ouvre l’onglet Bordures de la 
boîte de dialogue Formatage des cellules.

Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modèles dans Calc, pour plus de détails.
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Remarque

Les propriétés de bordure de cellule s’appliquent à une cellule, et ne peuvent être modifiées 
que dans cette cellule. Par exemple, si la cellule C3 a une bordure haute (ce qui est visuelle-
ment équivalent à une bordure basse dans C2), cette bordure ne pourra être supprimée 
qu’en sélectionnant C3. Elle ne pourra pas être supprimée dans C2.

Formater l’arrière-plan des cellules

Pour choisir rapidement une couleur d’arrière-plan pour une cellule ou d’un groupe de cellules, cli-
quez sur la petite flèche près de l’icône Couleur d’arrière-plan dans la barre d’outils Forma-
tage. Une palette de choix de couleurs, identique à la palette Couleur de police, est affichée.

Vous pouvez également utiliser l’onglet Arrière-plan de la boîte de dialogue Formatage des cel-
lules.

Le panneau Apparence de cellule dans l’onglet Propriétés du volet latéral contient un contrôle Ar-
rière-plan de cellule avec une palette de couleurs.

Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modèles dans Calc, pour plus de détails.

Appliquer un style aux cellules

Pour appliquer un style à une cellule ou à un groupe de cellules, utilisez le menu Styles qui pro-
pose des styles prédéfinis. Ceux-ci peuvent aussi être appliqués, supprimés des cellules ou modi-
fiés par l’intermédiaire de l’onglet Styles et formatage du volet latéral. Vous pouvez créer de nou-
veaux styles sélectionnant Styles > Nouveau style… dans la barre de menu ou Nouveau… dans 
le menu contextuel de l’onglet Styles et formatage. Saisissez un nouveau nom pour votre style ou 
cliquez sur un nom de style existant pour le mettre à jour. Vous pourrez par la suite modifier ou ef-
facer vos styles personnalisés grâce au menu contextuel de l’onglet Styles et formatage.

Formatage automatique des cellules

Avec l’AutoFormat

Vous pouvez utiliser la fonction AutoFormat de Calc pour mettre en forme rapidement et facilement
un groupe de cellules. Elle vous permet aussi de donner très facilement le même aspect à diffé-
rentes plages de la feuille. Toutes les mises en forme appliquées le sont par formatage direct.

 1) Sélectionnez les cellules que vous voulez formater dans au moins trois colonnes et trois 
lignes, y compris les en-têtes de colonnes et de lignes.

 2) Sélectionnez Format > Styles d’AutoFormat… dans la barre de menu pour ouvrir la boîte 
de dialogue AutoFormat (Figure 42).

 3) Choisissez le type et la couleur de formatage dans la liste.

 4) Sélectionnez les propriétés de formatage à inclure dans la fonction AutoFormat. La boîte de 
dialogue affiche immédiatement les effets des options que vous cochez ou décochez.

 5) Cliquez sur OK.
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Figure 42 : La boîte de dialogue AutoFormat

Définir un nouvel AutoFormat

Vous pouvez définir un nouvel AutoFormat qui sera disponible pour tous les classeurs.

 1) Mettez en forme le type de données, la police, sa taille, les bordures, l’arrière-plan, etc. d’une
plage d’au moins 4 cellules sur 4 puis sélectionnez-la.

 2) Sélectionnez Format > Styles d’AutoFormat… dans la barre de menu pour ouvrir la boîte 
de dialogue AutoFormat où le bouton Ajouter est maintenant actif.

 3) Cliquez sur Ajouter.

 4) Dans la zone Nom de la boîte de dialogue Ajouter un AutoFormat qui s’ouvre alors, tapez un
nom significatif pour le nouveau format.

 5) Cliquez sur OK pour l’enregistrer. Le nouvel AutoFormat est maintenant disponible dans la 
liste Format de la boîte de dialogue AutoFormat.

Remarque

Le nouvel AutoFormat est stocké sur votre ordinateur, dans votre profil utilisateur, et n’est 
donc pas accessible à d’autres utilisateurs. Ceux-ci peuvent cependant l’importer en sélec-
tionnant la plage dans le document et en l’utilisant pour définir un nouvel AutoFormat.

Utiliser les thèmes

Calc offre un ensemble prédéfini de thèmes de formatage (ensembles de styles) que vous pouvez 
appliquer aux classeurs. Il n’est pas possible d’ajouter de nouveaux thèmes à Calc ni de les modi-
fier. Vous pouvez toutefois modifier les styles d’un thème après l’avoir appliqué à un classeur. Ces 
styles modifiés ne seront disponibles que dans celui-ci quand vous l’enregistrez.

Pour appliquer un thème à un classeur :
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 1) Cliquez sur l’icône Sélectionner des thèmes
 dans la barre d’outils Outils. Si celle-ci n’est

pas visible, sélectionnez Affichage > Barres
d’outils dans la barre de menu et cliquez sur 
Outils. La boîte de dialogue Sélection de
thème s’ouvre (Figure 43). Il donne la liste des
thèmes applicables à l’ensemble du classeur.

 2) Choisissez le thème que vous désirez appliquer.
Dès votre choix effectué, les styles du thème
sont appliqués au classeur et immédiatement vi-
sibles.

 3) Cliquez sur OK.

 4) Si vous le souhaitez, vous pouvez utiliser l’on-
glet Styles et formatage du volet latéral pour mo-
difier certains styles. Ces changements n’affec-
teront pas le thème et ils ne s’appliqueront qu’au
classeur sur lequel vous travaillez.

Si vous le souhaitez, vous pouvez alors ouvrir la fe-
nêtre Styles et Formatage pour modifier des styles
particuliers. Ces modifications ne changent pas le
thème : elles ne font que changer l’apparence du style
dans le classeur précis que vous utilisez.

! Attention

Si vous appliquez un deuxième thème après un autre, les modifications des styles du pre-
mier thème seront supprimées au profit des styles du second thème.

Les thèmes appliqués au classeur s’appuient sur les styles de cellule. Certains changent même le 
style de cellule par défaut. Un nouveau jeu de styles, qui comprend un ensemble nommé Card, est
ajouté à votre document. La Figure 44 montre les styles ajoutés par le thème Feuilles d’automne.

Figure 44 : Styles de cellule du thème Feuilles d’automne.
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Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu’il change selon les conditions que vous 
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en dessous de la moyenne en rouge. Plusieurs options de 
mise en forme peuvent être saisies et disposées dans un ordre de priorité

Remarque

Pour appliquer un formatage conditionnel, Calculer automatiquement doit être activé. Co-
chez Données > Calculer > Calculer automatiquement.

Ce paramétrage est accessible par le menu Format > Formatage conditionnel. Voir le chapitre 2 
Entrer, modifier et formater des données du Guide Calc pour plus d’informations sur le formatage 
conditionnel.

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles ni imprimables, mais ils peuvent toujours
être sélectionnés pour une copie si vous sélectionnez les éléments autour d’eux. Par exemple, si 
la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. Quand vous 
avez à nouveau besoin d’un élément masqué, vous pouvez inverser le processus et afficher l’élé-
ment.

Pour plus d’informations sur comment masquer/afficher des données, en particulier pour utiliser les
outils Plans et groupes, ou le filtrage de données, voir le chapitre 2, Entrer, modifier et formater 
des données du Guide Calc.

Masquer des données

Pour masquer des feuilles :

 1) Sélectionnez les feuilles que vous voulez masquer.

 2) Sélectionnez Feuille > Masquer la feuille dans la barre de menu ou dans le menu contex-
tuel qui s’ouvre par un clic droit sur une des feuilles sélectionnées. Les feuilles ne sont plus 
visibles ni imprimées.

Vous ne pouvez pas masquer toutes les feuilles d’un classeur ; au moins une feuille doit rester vi-
sible.

Pour masquer des lignes ou des colonnes :

 1) Sélectionnez la ligne ou la colonne que vous voulez masquer.

 2) Sélectionnez Format dans la barre de menu et cliquez sur Ligne ou Colonne.

 3) Choisissez Masquer dans le menu et la ligne ou la colonne n’est plus visible ni imprimée.

Vous pouvez aussi faire un clic droit sur l’en-tête de la ligne ou de la colonne et cliquer sur Mas-
quer des lignes ou des colonnes dans le menu contextuel.
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Afficher les données masquées

Pour afficher des feuilles masquées, sélectionnez Feuille > Afficher les feuilles... dans la barre 
de menu ou dans le menu contextuel qui s’ouvre par un clic droit sur un onglet de feuille visible. 
Choisissez ensuite les feuilles que vous voulez de nouveau afficher dans la liste de la boîte de dia-
logue qui s’ouvre alors. Les feuilles redeviendront visibles et seront imprimées.

Pour afficher les lignes et colonnes masquées :

 1) Sélectionnez les lignes ou colonnes de chaque côté de celles qui sont masquées.

 2) Sélectionnez Format > Ligne ou Format > Colonne dans la barre de menu.

 3) Sélectionnez Afficher dans le sous-menu et la ligne ou la colonne sera affichée et pourra 
être imprimée.

Vous pouvez aussi faire un clic droit sur l’en-tête d’une ligne ou d’une colonne sélectionnée et cli-
quer sur Afficher les lignes ou les colonnes dans le menu contextuel.

Remarque

Si la première colonne (A) ou la première ligne (1) est masquée, vous devez sélectionner la 
feuille entière pour avoir accès à la commande Afficher pour cette ligne ou cette colonne.

Protection des cellules

Toutes ou certaines cellules d’un classeur peuvent être protégées par un mot de passe contre des 
modifications apportées par un utilisateur non autorisé. Cela peut être utile quand plusieurs per-
sonnes ont accès au classeur, mais que, pour diverses raisons, seules quelques-unes sont autori-
sées à en modifier les données.

Par défaut, toutes les cellules sont marquées protégées (Figure 45).

Avant de protéger la feuille, vous souhaiterez peut-être sélectionner certaines cellules qui resteront
non protégées et pourront être modifiées par n’importe quel utilisateur sans qu’il ait à saisir de mot 
de passe.

Pour cela :

 1) Sélectionnez les cellules que vous souhaitez ne pas protéger.

 2) Ouvrez la boîte de dialogue  Formatage des cellules,

─ en sélectionnant à Format > Cellules dans la barre de menu,

─ en faisant un clic droit dans la cellule et en choisissant Formater les cellules dans le 
menu contextuel,

─ en utilisant le raccourci Ctrl+1 du clavier.

 3) Décochez l’option Protégé dans la section Protection de l’onglet Protection de cellule (Fi-
gure 45).
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Figure 45 : L’onglet Protection de cellule de la boîte de dialogue Formatage des cellules.

Quand toutes les cellules ont reçu un état protégé ou non protégé :

 1) Sélectionnez Outils > Protéger la feuille dans la barre de menu.

 2) Dans la boîte de dialogue Protéger la feuille (Figure 46), cochez l’option Protéger cette 
feuille et le contenu des cellules verrouillées.

 3) Saisissez un mot de passe et confirmez-le.

 4) Cochez ou décochez les options de sélection des cellules.

 5) Cliquez sur OK.

À partir de ce moment, toute cellule qui a reçu l’état protégé ne pourra plus être modifiée sans mot 
de passe saisi au préalable.

Figure 46 ; la boîte de dialogue Protéger la feuille.

Les onglets des feuilles protégées sont marqués par l’icône d’un verrou comme on le voit sur la Fi-
gure 47.

Figure 47 : La feuille 2 est protégée (verrouillée).
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Au lieu de protéger des cellules une par une dans certaines feuilles, vous pouvez aussi choisir de 
protéger la totalité du classeur en sélectionnant Outils > Protéger le classeur… dans la barre de 
menu.

Dans la section Protection de l’onglet Protection de cellule de la boîte de dialogue Formatage des
cellules, vous trouverez aussi l’option Tout masquer pour cacher toutes les données contenues 
dans les cellules protégées.

Pour changer l’état masqué ou non de cellules protégées :

 1) Sélectionnez les cellules concernées.

 2) Sélectionnez Outils > Protéger la feuille dans la barre de menu.

 3) Dans la boîte de dialogue Protéger la feuille (Figure 46), saisissez le mot de passe pour pou-
voir modifier la feuille protégée et cliquez sur OK.

 4) Ouvrez la boîte de dialogue  Formatage des cellules,

─ en sélectionnant à Format > Cellules dans la barre de menu,

─ en faisant un clic droit dans la cellule et en choisissant Formater les cellules dans le 
menu contextuel,

─ en utilisant le raccourci Ctrl+1 du clavier.

 5) Dans l’onglet Protection de cellule (Figure 45), décochez les options de masquage des cel-
lules sélectionnées.

 6) Cliquez sur OK.

Remarque

Quand les données d’une cellule sont masquées, la cellule vide reste visible dans le clas-
seur.

Trier des enregistrements

Le tri modifie la disposition des cellules dans la feuille. Dans Calc, vous pouvez utiliser simultané-
ment plusieurs critères de tri, qui sont appliqués l’un après l’autre. Les tris sont pratiques quand 
vous cherchez un élément particulier, et sont encore plus puissants combinés aux filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est 
longue, il est habituellement plus facile d’ajouter des données en bas de la feuille, plutôt que d’in-
sérer des lignes à leur bonne place. Après avoir ajouté des données, vous pouvez les trier pour 
mettre à jour la feuille.

Si les données sont disposées en colonne et comportent un en-tête au format texte,
vous pouvez utiliser le tri rapide. Pour ceci, mettez en surbrillance les cellules à trier,
puis cliquez sur les boutons de barre d’outils Tri croissant ou Tri décroissant.

Pour trier les cellules de votre classeur :

 1) Sélectionnez les cellules à trier.

 2) Sélectionnez Données > Trier dans la barre de menu pour ouvrir la boîte de dialogue Trier 
(Figure 48).
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 3) Sélectionnez les critères de tri dans les listes déroulantes. Celles-ci sont remplies à partir 
des cellules sélectionnées.

 4) Cochez soit un tri ascendant (1-9, A-Z) soit un tri descendant (Z-A, 9-1).

 5) Cliquez sur OK pour que le tri soit effectué sur la feuille de calcul.

Figure 48 : La boîte de dialogue Critères de tri

Pour plus d’informations sur les options de tri, voir le chapitre 2, Entrer, modifier et formater des 
données du Guide Calc.

Commentaires de cellules

Les commentaires sont de petites notes qui peuvent servir de rappels ou de compléments d’infor-
mation pour l’utilisateur. Un commentaire n’est pas considéré comme une partie du classeur quand
il s’agit de calcul ou d’impression ; il n’apparaîtra que si la souris survole une cellule qui a été 
« commentée ».

La façon la plus simple pour insérer un commentaire consiste à faire un clic droit sur la cellule 
concernée puis à choisir Insérer un commentaire dans le menu contextuel. Vous pouvez aussi 
sélectionner Insertion > Commentaire dans la barre de menu, utiliser le raccourci Ctrl+Alt+C 
ou cliquer sur le bouton Insérer un commentaire ( ) de la barre d’outils Standard.

Par défaut, les commentaires sont masqués et n’apparaissent qu’au moment où la cellule est sur-
volée par la souris. Celles qui possèdent un commentaire sont marquées d’un petit carré rouge 
dans le coin supérieur droit. 

Nouveau depuis la version 5.4

Pour modifier la visibilité des commentaires, sélectionnez Affichage > Commentaires dans
la barre de menu.

Le sous-menu Feuille > Commentaires des cellules propose des entrées pour éditer, 
masquer, afficher ou supprimer le commentaire de la cellule sélectionnée et pour supprimer 
tous les commentaires.
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Utiliser les formules et les fonctions

Vous allez sans doute avoir besoin de plus que du texte et des nombres dans votre feuille de cal-
cul. Souvent le contenu d’une cellule dépend du contenu d’autres cellules. Calc permet de faire 
des calculs, des plus simples aux plus complexes en utilisant des formules. Les formules sont des 
équations qui utilisent des opérateurs, des fonctions, des nombres et des variables pour produire 
un résultat. Les variables font référence à des cellules qui contiennent les données nécessaires 
aux équations.

Pour saisir une formule, commencez par taper le symbole égal (=). Par exemple pour calculer en 
A3 la différence entre A1 et A2 :

Figure 49 : Résultat de la saisie de la formule

• sélectionnez la cellule A3;

• tapez le symbole = ou cliquez sur le bouton Fonction de la barre de formule  ;

• saisissez A1-A2 (en minuscules ou majuscules) ou utilisez la souris :

─ cliquez dans la cellule A1 (la référence apparaît dans la formule) ;

─ saisissez le symbole – pour calculer une différence ;

─ cliquez dans la cellule A2 (la référence apparaît dans la formule).

• Validez par la touche Entrée.

La formule finale doit être :

=A1-A2

La cellule A3 affiche le résultat et la barre de formule affiche la formule comme sur la Figure 49.

Les principaux opérateurs sont :

Opérateurs principaux Symboles

Addition +

Soustraction -

Multiplication *

Division /

Élévation à la puissance ^ (touche Alt Gr+9)

Outre les opérateurs listés ci-dessus, Calc dispose de fonctions. Une fonction est un calcul prédéfi-
ni saisi dans une cellule pour vous aider à analyser ou manipuler des données. La seule chose 
que vous avez à faire est d’ajouter des arguments et le calcul est automatiquement fait pour vous. 
Les fonctions vous aident à créer les formules nécessaires à l’obtention des résultats que vous re-
cherchez.
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Par exemple, vous désirez faire la somme des cellules A1 à E1, avec l’opérateur + vous devez sai-
sir une formule du type :

=A1+B1+C1+D1+E1

Plus le nombre de cellules à additionner sera grand, plus longue et fastidieuse à écrire sera la for-
mule. LibreOffice permet de simplifier l’opération en utilisant la fonction SOMME qui demande uni-
quement l’adresse d’une plage de cellules et non la liste de toutes les cellules. Par exemple :

=SOMME(A1:E1)

L’assistant Fonction et la recherche de fonctions

Les fonctions et formules peuvent être saisies directement dans la barre de formule (comme ci-
dessus) ou avec l’aide de l’assistant Fonction. Pour ouvrir celui-ci, cliquez sur son icône ( ) si-
tuée à droite de la zone de nom.

Figure 50 : L’assistant Fonction avec la boîte de recherche.

À l’intérieur de cet assistant, vous pouvez rechercher une fonction parmi le grand nombre de celles
qui sont disponibles. Vous pouvez aussi compléter la fonction choisie sans quitter l’assistant pour 
ne pas avoir à la saisir dans la barre de formule.
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Une fois la formule sélectionnée, l’assistant offre une brève explication de son utilisation et de sa 
syntaxe correcte, ainsi que des boîtes de saisie, où vous pouvez entrer les informations néces-
saires à la fonction, et une boîte de résultat qui vous montrera le résultat correspondant aux don-
nées saisies.

Remarque

Le volet latéral de Calc offre un onglet Fonctions ( ) comme alternative à l’assistant. Il offre
une liste des fonctions accompagnées d’une brève explication de leur utilisation et de leur 
syntaxe, mais ne propose pas les fonctions de recherche et de saisie des données que l’on 
trouve dans l’assistant.

Référez-vous au chapitre 7, Formules et fonctions, du Guide Calc pour plus d’informations.

Analyser les données

Calc offre plusieurs outils pour vous aider à analyser les informations contenues dans les feuilles 
de calcul, allant des fonctions pour copier et réutiliser les données, à celles permettant de créer 
automatiquement des sous-totaux ou encore à faire varier l’information pour vous aider à trouver 
les réponses que vous cherchez. Ces outils sont accessibles par les menus Données et Outils.

Calc propose aussi de nombreux outils d’analyse statistique des données qui vous permettent 
d’obtenir des informations numériques importantes sur les données provenant de mesures phy-
siques, de sondages ou même de transactions commerciales telles que des ventes, des cotations 
boursières, etc. Ces analyses de données statistiques sont accessibles par le menu Données > 
Statistiques. Voir le chapitre 9, Analyse de données du Guide Calc pour plus d’informations sur 
les outils proposés par Calc dans ce but.

Un autre outil d’analyse de Calc est la possibilité de créer des diagrammes pour visualiser les don-
nées. Les possibilités offertes sont très riches. Référez-vous au chapitre 3, Créer des diagrammes
et des graphiques, du Guide Calc pour plus d’informations.

Tables et diagrammes dynamiques

L’un des outils les plus utiles est la Table dynamique (anciennement Table de pilote). 

Une table dynamique est un moyen qui permet d’organiser, de manipuler et de résumer de 
grandes quantités de données pour en faciliter la lecture et la compréhension tout en vous permet-
tant de répondre à différentes questions sur votre classeur en réarrangeant les données que vous 
y avez saisies.

Supposons, par exemple, que vous avez un classeur qui contient une liste de dons à diverses 
œuvres de charité par un groupe de recruteurs sur plusieurs mois, mais que vous ne vous intéres-
sez qu’à la somme totale collectée par chaque recruteur. Pour répondre à cette question, vous 
pourriez calculer manuellement cette somme grâce aux options de tri et de mise en forme offertes 
par Calc.

Vous pouvez aussi disposer une table dynamique comme sur la Figure 51 pour faciliter la lecture 
et l’organisation des données.

Pour ouvrir la boîte de dialogue de création d’une table dynamique, sélectionnez Insertion > Table
dynamique… ou Données > Table dynamique > Créer dans la barre de menu. Celle-ci va devi-
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ner de manière intelligente les en-têtes des colonnes d’après les données brutes fournies pour les 
insérer dans la boîte de sélection des Champs disponibles. À partir de celle-ci, vous pouvez glis-
ser-déposer ceux qui vous intéressent dans les Champs de colonne, de ligne et de données pour 
organiser la table à votre convenance. Cliquez sur OK pour voir le résultat.

Figure 51 : La boîte de dialogue Mise en page de la table dynamique avec les données brutes et
les résultats.

Pour choisir de nouvelles informations à afficher ou pour modifier leur disposition, faites un clic 
droit dans la table dynamique pour ouvrir le menu contextuel et sélectionnez Éditer la mise en 
page…

Référez-vous au chapitre 8, Utiliser la table de pilote, du Guide Calc pour plus d’informations sur 
les tables dynamiques.

Diagrammes de tables dynamiques

Pour obtenir une représentation visuelle des données contenues dans une table dynamique, il est 
possible de créer un diagramme de table dynamique.

D’un point de vue fonctionnel, un diagramme de table dynamique est pratiquement identique à un 
diagramme ordinaire, sauf dans deux domaines importants. D’une part, quand les données de la 
table dynamique sont modifiées, le diagramme s’ajuste automatiquement pour les refléter. D’autre 
part, il comporte des boutons de champ, éléments graphiques qui vous permettent de filtrer le 
contenu de la table dynamique depuis le diagramme lui-même, ce qui offre un gain de temps utile 
si la table et le diagramme sont situés dans des feuilles différentes.

Référez-vous au chapitre 3, Créer des diagrammes et des graphiques du Guide Calc pour plus 
d’informations sur les diagrammes en général et les diagrammes de table dynamique, ainsi qu’au 
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chapitre 8, Utiliser la table de pilote, pour plus d’informations sur les tables dynamiques elles-
mêmes.

Impression

L’impression à partir de Calc est pratiquement la même qu’à partir des autres modules de 
LibreOffice (voir le chapitre 10, Impression, exportation, mailing, de ce guide) mais certains détails 
sont différents surtout en ce qui concerne la préparation à l’impression.

Utiliser les zones d’impression

Les zones d’impression ont plusieurs utilisations, elles permettent de n’imprimer qu’une partie spé-
cifique des données ou de lignes ou colonnes sélectionnées sur chaque page. Pour plus d’infor-
mations sur les zones d’impression, voir le chapitre 6, Imprimer, exporter et envoyer par e-mail du 
Guide Calc.

Définir une zone d’impression

Pour définir une nouvelle zone d’impression ou modifier une zone d’impression existante :

 1) Sélectionnez la plage de cellules qui compose la zone d’impression.

 2) Choisissez Format > Zones d’impression > Définir dans la barre de menu. Les lignes de 
délimitation des pages s’affichent à l’écran.

 3) Vous pouvez vérifier la zone d’impression en sélectionnant Fichier > Aperçu ou en cliquant 
sur l’icône Aperçu . LibreOffice n’affichera que les cellules à l’intérieur de la zone d’im-
pression.

Conseil

Le mode Affichage >Sauts de page permet également de facilement repérer la zone d’im-
pression sans passer par l’aperçu avant impression.

Ajouter une plage à la zone d’impression

Après avoir défini une zone d’impression, vous pouvez lui ajouter des cellules supplémentaires. 
Ceci permet d’imprimer plusieurs zones séparées dans la même feuille, sans avoir à imprimer 
celle-ci en entier.

Après avoir défini une zone d’impression :

1) Sélectionnez la plage de cellules à ajouter à la zone d’impression.

2) Choisissez Format > Zones d’impression > Ajouter dans la barre de menu. Les cellules 
supplémentaires sont alors ajoutées à la zone d’impression.

3) Vous pouvez vérifier la zone d’impression en utilisant Fichier > Aperçu. Ou cliquer sur 
l’icône Aperçu  LibreOffice n’affichera que les cellules à l’intérieur de la zone d’impres-
sion.

Les lignes de délimitation des pages ne s’affichent plus à l’écran.
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Remarque

La zone d’impression supplémentaire sera imprimée sur une page séparée, même si les 
deux zones sont sur la même feuille.

Supprimer une zone d’impression

Il peut devenir nécessaire de supprimer une zone d’impression définie, s’il faut imprimer la feuille 
entière par exemple.

Choisissez Format > Zones d’impression > Effacer dans la barre de menu. Ceci va supprimer 
toutes les zones d’impression définies dans la feuille. Une fois la zone d’impression supprimée, les
lignes de délimitation de page par défaut s’afficheront de nouveau à l’écran.

Éditer une zone d’impression

À tout moment vous pouvez éditer directement la zone d’impression par exemple pour supprimer 
ou redimensionner une partie de la zone. Choisissez Format > Zones d’impression > Éditer pour
ouvrir la boîte de dialogue Éditer les zones d’impression où vous pouvez définir celles-ci.

Options d’impression

Pour sélectionner l’ordre des pages, les détails et l’échelle :

 1) Choisissez Format > Page dans la barre de menu.

 2) Dans la boîte de dialogue Style de page (Figure 52), sélectionnez l’onglet Feuille.

 3) Faites votre sélection et cliquez ensuite sur OK.

Pour plus d’informations sur les options d’impression, voir le chapitre 6, Imprimer, exporter et en-
voyer par e-mail du Guide Calc.

Figure 52 : Onglet Feuille de la boîte de dialogue Style de page
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Imprimer des lignes ou colonnes sur chaque page

Si une feuille s’imprime sur plusieurs pages, vous pouvez paramétrer l’impression pour que cer-
taines lignes ou colonnes soient répétées sur chaque page.

Par exemple, si les deux premières lignes, ainsi que la colonne A, doivent être imprimées sur 
toutes les pages, effectuez les opérations suivantes :

1) Choisissez Format > Zones d’impression > Éditer dans la barre de menu. Dans la boîte 
de dialogue Éditer les zones d’impression (Figure 53) saisissez les lignes dans la boîte de 
saisie de texte sous Lignes à répéter. Par exemple, pour répéter les lignes 1 et 2, tapez 
$1:$2. Cela va modifier Lignes à répéter de – aucun – à – défini par l’utilisateur -.

2) Pour répéter des colonnes, saisissez-les dans la boîte de saisie de texte sous Colonnes à 
répéter. Par exemple, pour répéter la colonne A, tapez $A. Cela va modifier Colonnes à ré-
péter de – aucun – à – défini par l’utilisateur -.

3) Cliquez sur OK.

Remarque

Vous pouvez également sélectionner les lignes ou colonnes à répéter avec la souris. Pour 
ceci, positionnez le curseur dans la zone de saisie de texte correspondante, puis sélection-
nez dans la feuille la plage de cellules désirée. Il n’est pas nécessaire de sélectionner des 
lignes ou colonnes entières : une cellule de chaque ligne ou colonne suffit.

Pour plus d’information sur l’édition des plages à imprimer, voyez le Guide Calc, Chapitre 6, Impri-
mer, exporter et envoyer par e-mail.

Figure 53 : Définir des lignes à répéter

Sauts de page

Si la définition de zones d’impression peut être un puissant outil, il est parfois nécessaire d’ajuster 
manuellement l’impression dans Calc. Pour ceci, vous pouvez utiliser un saut de page manuel. Un 
saut de page manuel vous aide à vous assurer que vos données vont s’imprimer correctement en 
accord avec la taille et l’orientation de la page imprimée. Vous pouvez insérer un saut de page ho-
rizontal au-dessus de la cellule active, ou un saut de page vertical à gauche de celle-ci.

Pour plus d’informations sur les sauts de page manuels, voyez le chapitre 6, Imprimer, exporter et 
envoyer par e-mail du Guide Calc.
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Insérer un saut de page

Pour insérer un saut de page :

 1) Activez la cellule où le saut de page va commencer.

 2) Sélectionnez Feuille > Insérer un Saut de page dans la barre de menu.

 3) Choisissez Saut de ligne pour créer un saut de page au-dessus de la cellule sélectionnée 
ou Saut de colonne pour le créer à gauche de cette cellule.

Le saut de page est alors paramétré.

Saut de ligne

Saut de ligne va créer un saut de page au-dessus de la cellule sélectionnée. Par exemple, si la 
cellule active est H15, le saut de page est alors placé entre les lignes 14 et 15.

Saut de colonne

Saut de colonne va créer un saut de page à gauche de la cellule sélectionnée. Par exemple, si la 
cellule active est H15, le saut de page est alors placé entre les colonnes G et H.

Conseil

Pour voir plus facilement les sauts de page à l’écran, vous pouvez changer leur couleur. 
Choisissez Outils > Options > LibreOffice > Couleurs de l’interface et faites défiler la 
liste jusqu’à la section Classeur.

Supprimer un saut de page

Pour supprimer un saut de page :

1) Activez la cellule près du saut de page à supprimer.

2) Sélectionnez Feuille > Supprimer le saut de page dans la barre de menu.

3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors supprimé.

Remarques

Plusieurs sauts de ligne et de colonne manuels peuvent exister dans la même feuille. Si 
vous voulez les supprimer, vous devez supprimer chaque saut individuellement (voir l’astuce
suivante). Cela peut parfois être difficile, car bien qu’il puisse y avoir un saut de colonne pa-
ramétré dans la feuille, quand vous sélectionnez Feuille > Supprimer le saut de page, le 
choix Saut de colonne peut être indisponible (grisé).

Pour supprimer le saut de page, vous devez être dans la cellule à côté de celui-ci. Par 
exemple, si vous avez défini un saut de colonne alors que vous étiez en H15, vous ne pou-
vez pas le supprimer si vous êtes dans la cellule D15. Cependant, vous pouvez le supprimer
depuis n’importe quelle cellule de la colonne H.

Conseil

Vous pouvez également utiliser l’option Supprimer tous les sauts manuels du menu 
contextuel si vous avez sélectionné Affichage > Sauts de page.
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En-têtes et pieds de page

Les en-têtes et pieds de page sont des éléments de texte prédéfinis qui sont imprimés respective-
ment en haut et en bas d’une page, en dehors de la zone réservée aux cellules. Les en-têtes et les
pieds de page fonctionnent de la même façon. Pour plus d’informations sur la création des en-
têtes et des pieds de page, voyez le chapitre 6, Imprimer, exporter et envoyer par e-mail du Guide 
Calc.

Les en-têtes et les pieds de page sont affectés à des styles de page. Vous pouvez définir plus d’un
style de page dans un classeur et attribuer des styles de page différents aux différentes feuilles. 
Pour plus d’informations sur ces styles, voyez le chapitre 4, Utiliser les styles et les modèles dans 
Calc, du Guide Calc.

Définir un en-tête ou un pied de page

Pour paramétrer un en-tête ou un pied de page :

 1) Sélectionnez la feuille dont vous voulez paramétrer l’en-tête ou le pied de page et choisissez
Format > Page dans la barre de menu.

 2) Sélectionnez l’onglet En-tête (Figure 54) (ou Pied de page) dans la boîte de dialogue Style 
de page.

 3) Cochez l’option Activer l’en-tête (ou Activer le pied de page).

 4) Cochez l’option Même contenu sur les pages de droite et de gauche si vous voulez que le 
même texte apparaisse sur les pages de droite comme de gauche.

Figure 54 : Boîte de dialogue Style de page – Pied de page

À ce stade, vous pouvez également paramétrer les marges, l’espacement et la hauteur de l’en-tête
ou du pied de page. Vous pouvez cocher la case Adaptation dynamique de la hauteur pour ajuster 
automatiquement la hauteur de l’en-tête ou du pied de page.

Marges

La taille des marges gauche et droite ajuste la distance de l’en-tête ou du pied de page par 
rapport aux côtés de la page.
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Espacement

L’espacement détermine la distance au-dessus ou en dessous de la feuille à laquelle l’en-
tête ou le pied de page sera imprimé. Ainsi, si l’espacement est de 1 cm, il y aura un espace 
de 1 cm entre la feuille et l’en-tête ou le pied de page.

Hauteur

La hauteur représente la taille de l’en-tête ou du pied de page.

Pour modifier l’apparence de l’en-tête ou du pied de page, cliquez sur le bouton Plus, ce qui va 
ouvrir la boîte de dialogue Bordures / Arrière-plan. À partir de cette boîte de dialogue, vous pouvez
définir l’arrière-plan et la bordure de l’en-tête ou du pied de page. Pour plus d’informations, voir le 
chapitre 4 Utiliser les styles et les modèles dans Calc dans le Guide Calc.

Pour définir le contenu de l’en-tête ou du pied de page (numéro de page, date, etc.), cliquez sur le 
bouton Éditer dans la boîte de dialogue de la Figure 54 afin d’afficher la boîte de dialogue En-tête 
(ou Pied de page). Pour plus d’informations, voyez le chapitre 6, Imprimer, exporter et envoyer par
e-mail du Guide Calc.

! Attention

Toutes les feuilles utilisant le même style de page seront modifiées. Si vous souhaitez des 
en-têtes et pieds de page différents suivant les feuilles, vous devez leur attribuer des styles 
de page différents.
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